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1. Installation Procedure

1.1 Downloading Bernie

Bernie is available as a CompactPro™ or StuffIt™ archive. 
To install Bernie, follow these steps:

download Bernie from the F.E.Systems web site at 
http://www.magnet.ch/emutech/Download/ .

Decompress the software with StuffIt Expander™. If your 
mainstream web browser is properly installed, it should 
decompress the Bernie archive automatically. We are 
also offering Bernie as a CompactPro archive if you do 
not have StuffIt installed.

1.2 Obtaining a ROM Dump

Since Bernie is a software-only emulator, it requires a copy 
of the Apple IIgs ROM. We are not allowed to include this 
code due to the copyrights that prevent us from doing so. 
Consequently, you have to create an image of a Apple IIgs 
ROM yourself.

Bernie can handle both ROM 01 and ROM 3. You can install 
either of them, or both at the same time. The ROM dump(s) 
must be located in the same folder as the Bernie 
application. The ROM file(s) go by "Apple IIgs ROM 01" or 
"Apple IIgs ROM 3", respectively. Bernie will find the files no 
matter how they're labeled and renames them appropriately. 
You only need to throw them into the Bernie application 
directory. (Please decompress the files manually if they 
have been compressed before.)

Here's how you can make a ROM dump of a Apple IIgs 
ROM. Please be sure to follow these steps precisely, 
otherwise your ROM dump might end up being corrupted:

http://replay.web.archive.org/20010703053714/http://www.magnet.ch/emutech/Download/


turn on your Apple IIgs and boot into ProDOS 8
If you have a ROM 1 Apple IIgs enter the following text (do 

not enter the "]" and "*") ]call -151*0/800<FE/0.7FFFM
*BSAVE ROM1,A$800,L$8000*0/800<FE/8000.FFFFM
*BSAVE ROM1,A$800,L$8000,B$8000*0/800<FF/0.7FFFM
*BSAVE ROM1,A$800,L$8000,B$10000*0/800<FF/8000.FFFFM
*BSAVE ROM1,A$800,L$8000,B$18000

If you have a ROM 3 Apple IIgs enter the following text (do 
not enter the "]" and "*") ]call -151*0/800<FC/0.7FFFM
*BSAVE ROM2,A$800,L$8000*0/800<FC/8000.FFFFM
*BSAVE ROM2,A$800,L$8000,B$8000*0/800<FD/0.7FFFM
*BSAVE ROM2,A$800,L$8000,B$10000*0/800<FD/8000.FFFFM
*BSAVE ROM2,A$800,L$8000,B$18000*0/800<FE/0.7FFFM
*BSAVE ROM2,A$800,L$8000,B$20000*0/800<FE/8000.FFFFM
*BSAVE ROM2,A$800,L$8000,B$28000*0/800<FF/0.7FFFM
*BSAVE ROM2,A$800,L$8000,B$30000*0/800<FF/8000.FFFFM
*BSAVE ROM2,A$800,L$8000,B$38000

In the Apple IIgs Finder, copy the file(s) ROM1 and/or ROM2 
to a disk that has been formatted as a HFS (Macintosh) 
disk before. Do NOT use a ProDOS disk.

Insert this disk into your Mac's disk drive and move the 
ROM file(s) into the Bernie application directory.

CAUTION: Do not use a ProDOS-formatted disk for 
copying the ROM file(s). Always use a Macintosh 
(HFS) disk.

Making a ROM dump is not for the faint-hearted. If you feel 
you need additional help, we will gladly help you.

1.3 Packaging List

When you have downloaded everything, you should have 
the following files all in the same directory:



Bernie ][ The Rescue application
a ROM 01 dump (optional if you also have a Rom 3 dump)
a ROM 3 dump (optional if you also have a Rom 01 dump)
Documentation (User's Manual)
Register application
Release Notes
Application Notes
Please read the Release Notes carefully. They contain late-
breaking news and explain with just a few words what has 
changed since the previous release.

The Application Notes is a document that discusses specific 
Apple II application and how they interact with Bernie, what 
settings should be used for best performance etc.

1.4 Everything In Place?

When you now start the Bernie application, you should see 
(in that order):

a registration screen - push the "Not Yet" button when it 
becomes available or enter your registration key

a large blue window with an error message saying "Check 
Startup Device"

The error message "Check Startup Device" is exactly what 
you'd see on a real Apple IIgs if you turned it on without 
inserting a disk. In other words, your Mac has now been 
taught hardware-emulating a IIgs, now it's time to shop for 
the software.

Congratulations, you now have a full-featured Apple IIgs® 
running on your Macintosh® hardware!



1.5 Where To Go From Here

We recommend you to read the rest of this Getting Started 
section and try the various options on the living object. You 
do not need system software for exploring most emulation-
related features. Once you got familiar with the emulator, 
you can start using Apple IIgs software.

At this time, you might want to learn what other people are 
doing with Bernie. Consider subscribing to the Bernie 
mailing list, a mailing list that focuses on Apple II emulation 
with Bernie. Details on subscriptions are available on the 
web. The Bernie crew is monitoring the mailing list and 
providing answers in case your feeding questions into it.

Upon reading this section, you should get your hands on a 
few disk images. Most will already be eager to recycle their 
huge software archive. If you do not have Apple IIgs 
software within reach, consider downloading a few titles 
from the Internet (see our Download page for links).

Next, we very strongly recommend you to learn the details 
of Bernie's disk handling as described in the Storage 
section. It's not a particularly simple topic but crucial for 
having an enjoyable time with Bernie.

For the ultimate support experience, we would also be glad 
to welcome you in Delphi's Apple forum. We are doing 
online support there as our time permits and would enjoy 
talking to you. Look for the Apple II forum.

Finally, have a look at the remaining chapters (video, 
audio, printing).
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2. Starting Bernie ][ The 
Rescue

Once you have completed the steps in chapter 1, you're 
ready for liftoff. The Bernie team at F.E.Systems wishes you 
a great time with Bernie!

2.1 Memory

Bernie has been designed to work in small memory 
partitions ("heaps"). The factory setting is approx. 4.5 Mb 
RAM. This application size is about the equivalent of a 
1.5Mb Apple IIgs system. (Ca. 3 megabytes are reserved for 
Bernie, all remaining free RAM will be allocated for Apple 
IIgs memory.) If you would like to increase available Apple 
IIgs memory, follow these steps:

Make sure Bernie is not already running. If it is, choose Quit 
from Bernie's File menu.

Locate the Bernie application on your Mac and highlight its 
icon in the Finder window

Choose "Get Info" from the File Menu (in the Finder)
If you are running MacOS 8.5 or later, choose "Memory" 

from the popup.
Enter a new application size in the "preferred" text box. 

Each additional 64 kB will translate into 64 additional 
kilobytes of Apple IIgs memory.

Close the window
The next time you start Bernie, the changes in memory 
allocation will take effect. Please keep in mind that Bernie 
will not allocate more than 8 megabytes and not more than 



14 megabytes with the ViagRAM™ 14Mb option enabled. A 
stock Apple IIgs does not support more than 8Mb of RAM.

2.2 Working with Bernie ][ The Rescue

2.2.1 Keyboard

Bernie translates Mac keyboards into Apple IIgs key codes. 
Bernie does also support international character sets.

There are just a few important special keys on your Mac 
keyboard:

The Apple IIgs Reset key is the delete key on the Mac 
keyboard. The Mac's shutdown/startup key retains its 
original function. The delete key allows you to reset 
(control+delete) and reboot 
(control+command+delete) the system.

The keypad may not work as expected. If you are trying to 
type on the keypad and nothing happens, make sure 
you have disabled joystick emulation via the keypad. To 
turn it off, choose "Joystick Support/None" from the 
Setup menu

To access Macintosh menu key commands, press 
command-shift-[key] instead of command-
[key].

Tidbit: On slower Macs, consider enabling keyboard 
buffering in the Apple IIgs' Classic Control Panel:

push command-control-escape
enter the Control Panels section
choose the Keyboard panel
activate keyboard buffering



2.2.2 Customized Keyboard Layouts 

Bernie is shipping with customized keyboard layouts for 
your Mac. The layouts tell your Mac to let through certain 
key combinations that are crucial for a few applications such 
as ProSEL and AppleWorks UltraMacros. The Bernie 
keyboard layouts are included with the Bernie application 
and must be installed first:

locate the file "Bernie Keyboard - U.S." or an international 
variant that matches your requirements. Layouts for 
French, British, German and Dvorak keyboards are 
included. (Users of earlier versions of Bernie can 
download the layouts from the web.)

grab the file with the mouse and drop it onto the system 
suitcase of your start disk. The system suitcase is 
located on your startup disk in the system folder. It's the 
file titled "System".

If the operation has been successful, you will notice a menu 
to the right on the Mac menu bar - next to the 
applications menu - that is now listing the keyboard 
layout you just copied/moved.

Bernie's keyboard layout handling is very flexible and allows 
for simultaneous use of a customized Bernie layout while 
retaining the original layout in other applications running in 
the background. To activate automatic layout switching, 
please open the Preferences menu (from the Setup menu):

Check the box Remember Last Keyboard. Bernie will now 
behave as follows:

When you switch to another application, the keyboard layout 
that was active before you launched Bernie will be 
made available

Upon returning to Bernie, the layout that was active before 
you put Bernie into background will be restored

When you quit Bernie and "Remember Last Keyboard 
Layout" is checked, Bernie will try to activate the layout 
when you launch Bernie the next time



2.2.3 Function Keys

Bernie also supports function keys. The keys are reserved as 
follows:

F5 toggle Joystick

F6 toggle Mouse

F7 sound on/off

F8Shift-F8

Power Mode on/offPut 
Bernie into background 
and make the Finder 
active

F9
Speed Nanny on 
(regulated emulation 
speed)

F10 a wee bit slower

F11 a wee bit faster

F12 Speed Nanny off: max. 
speed

Shift-F13 Power off-on (cold reset)

Shift-F14 Shutdown (quit Bernie)

F15 Halt

  

2.2.4 Mouse

For most desktop based Apple IIgs applications, the mouse 
switching is done automagically by Bernie. However, if the 
application is not using the Event Manager to poll the 



mouse, you have to manually turn on mouse emulation to 
use it as an Apple IIgs mouse. You need to enable Mouse 
Support when you are running an application with mouse 
control and nothing happens when you're moving the 
mouse.

There's an easy shortcut to switch between Mac and GS 
mouse: Command-Shift-M. Alternately, you can also click 
in the Video window while holding down Command-Shift.

The mouse is polled 30 times a second which is sufficient in 
most situations. If you feel the mouse is jerky and 
unresponsive, you can double accuracy by:

opening the Preferences window from the Setup menu
clicking the Video panel (the second icon which shows parts 

of a monitor)
activate "Smooth Mouse Tracking"
Note that updating mouse position more frequently has a 
marginal impact on execution speed.

2.2.5 Joystick

Games are more fun when played with a joystick. Bernie 
offers varies "emulations" for getting the most out of your 
input devices.

Input Sprockets Support

Input Sprockets is a technology from Apple Computer. It's a 
programming interface that offers unified code for controlling 
joystick-like input devices from a various manufacturers.

If you have Input Sprockets installed, be sure to have the 
check box "Use InputSprocket" checked. This enables 
InputSprockets code. Joystick configuration takes place in a 
separate window that you can open by pushing the 
"Configure InputSprocket Joysticks" button.



Direct Joystick Support

Besides InputSprockets, Bernie also supports certain 
joysticks directly. These include the Gravis GamePad and 
MouseStick devices.

When you open the Setup menu, you will find a menu item 
"Joystick..". This menu lets you choose one of the following 
emulations:

None: do not emulate joysticks at all
Keypad: use the keypad to simulate joystick movement. 

The keys are 8 for up, 6 right, 4 left, 2 down, and 5 to 
center the joystick. Note that you can tell Bernie to 
center the joystick automatically. (See below.)

Mouse: you may also want to use the mouse.
Other: when choosing "Other", Bernie takes you to the 

Preferences panel and the Joystick section. Here you 
can select MouseStick and GamePad devices 
connected to your Mac. Using dedicated joysticks for 
emulation is always a good idea as it doesn't block 
other input devices such as keypad and mouse for 
regular activities.

The Joystick panel is part of the Preferences panel and 
lets you refine joystick emulation

Bernie emulates up to two joysticks. We're aware of only 
game supporting two joysticks (Super Star Icehockey), but 
since that's our all-time favorite it was worth adding support 
for two devices. The popup menus will also list GamePad 
and MouseStick devices.

If you have a GamePad or MouseStick attached to 
your system and the corresponding popup menu 
items are dimmed, please make sure their control 
panels (on the Mac side) are properly installed and 
loaded.

Autocenter is an option for joystick emulation via keypad. 



When you do not steer to a particular direction, Bernie will 
center the joystick. You could do so by pushing 5 on the 
keypad, but enabling this option frees you from doing so.

Joystick emulation is a tricky thing because timing circuits 
are hard to emulate. Even on the real hardware calibrating a 
joystick has often been a daunting task. If Bernie does not 
work well with your software because the emulated joystick 
seems to be badly calibrated, you can adjust it with the 
Adjust Ratio slider.

2.3 Starting Emulation

As soon as Bernie is loaded, emulation is running. To pause 
emulation, choose "Pause" from the Setup menu.

2.4 SpeedNanny

SpeedNanny is a tool for controlling the speed at which 
Bernie is emulating. If SpeedNanny is turned off, Bernie is 
humming along at top speed, typically far beyond that of a 
stock IIgs.

To control performance of Bernie, open the Preferences 
window:

If Speed Control is checked, the speed slider and popup 
menu become active:

choose a base speed from the popup menu
if you would like to fine-tune emulated speed, use the 

speed slider
The SpeedNanny menu command from the Setup menu 
toggles between control speed and full speed.

You can control SpeedNanny via function keys as well. See 



the previous chapter ("Function Keys") for details.

2.5 Zip Chip™ Support
A stock Apple IIgs is running at a rather 2.8Mhz. That's why 
accelerators such as the Zip Chip™ have been a popular 
add-on.

Bernie adds support for a virtual Zip Chip. This means that 
Zip Chip-aware software thinks there is a Zip Chip built into 
Bernie.

If speed control/SpeedNanny is enabled, Bernie will perform 
at the speed level the virtual Zip Chip is set to. For example, 
when your Apple IIgs software sets the Zip Chip to 9 Mhz, 
then Bernie will run at 9Mhz.

(If Bernie does not support a specific speed, it will tune in on 
the next higher speed.)

2.6 ViagRAM™ Memory Enhancer

Bernie comes with ViagRAM™, the tool for almost doubling 
available memory. With ViagRAM™ enabled, your Apple 
IIgs software can see up to 14Mb of RAM.

Please note that in order to take advantage of ViagRAM™, 
you need to allocate enough memory to Bernie. For the full 
14Mb of RAM, you'd need to increase Bernie's application 
size to 17 Mb.

Please note that ViagRAM™ patches the system and a few 
programs make assumptions about how memory behaves 
and how much is available. ViagRAM might invalidate these 
assumptions so the software is incompatible with the patch. 
One software that is known to be incompatible is 
AppleWorks Classic.
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3. Miscellaneous

3.1 Switching ROMs

The Setup menu has a submenu "Switch ROM" that 
displays the ROM currently in use. Depending on which 
ROM dump you have installed, one of the two choices may 
be disabled.

If select a ROM dump in the "Switch ROM" submenu, 
Bernie will load the selected ROM and cold boot Bernie. You 
can't switch ROMs on the fly without rebooting the virtual 
IIgs.

Tidbit: You can use the "Switch ROM" command to apply 
changes you made to the slot settings. When switching a 
particular slot from "Your Card" to its built-in function 
(Printer, Disk Port, etc.) or vice versa, the change will not 
be applied immediately. Instead, you have to completely 
reboot the emulated Apple IIgs in order to make the 
changes take effect. This is particularly important when 
you'd like to print with "InkMeister" (Bernie's proprietary 
printing technology) and discover that the slot setting for slot 
1 is wrong. It is not sufficient to just toggle the slot setting 
from "Printer" to "Your Card" but you also need to reboot the 
emulated Apple IIgs. The "Switch ROM" command does 
exactly this.

We are often being asked if there's a major difference 
between ROM 01 and ROM 3. The answer is: no, there isn't. 
ROM 3 is slightly faster with Bernie, but the key benefits of 
the ROM 3 machines were mostly in hardware design.



3.2 Miscellaneous Preferences

The Preferences window contains a "generic settings" 
panel. To access it, open the Preferences window and click 
the panel "This & That". Here's a short description of what 
some more obnoxious items do:

3.2.1 Special Sound Effects

Emits nostalgic sounds when ejecting disks etc.

3.2.2 Pause Emulation When In Background

Switches to pause mode when you hop to another 
application. This also affects emulation when you put Bernie 
into background with the Shift-F8 shortcut.

3.2.3 Warn On Reset and Shut Down

Displays warnings when you're about to loose data (by 
resetting etc.). Experienced users will find these warnings 
pretty annoying, but if you're new to Bernie you might want 
to enable them for a while.

3.2.4 Remember Last Keyboard Layout

See chapter about Keyboards for more information.
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3.2.5 Support For Extended Keyboards

If this option is enabled, Bernie will not map own functions to 
the function keys. Instead, function keys are passed to the 
Apple II software.

Please note that with Support For Extended Keyboards, it is 
not possible to disable Mouse Support, Speed Control or 
Power Mode with function keys. Remember their key 
shortcuts!

3.2.6 Hide Mac Cursor While Typing

Well, hides the Mac cursor while typing.

3.2.7 Allow GS Clock To Overwrite Mac Clock

Bernie offers RTC (Real-Time Clock) support. When 
software attempts to set the clock to a new date, you have 
the choice to write this change through to the Mac layer.

3.3 Getting Help

You might run into situations where you would appreciate 
some help.

We are offering you different sources of help. Most 
importantly, please read the remaining chapters. This 
introduction only scratches the surface and is not supposed 
to reveal all the secrets.

Next, Bernie has a Help menu where you can enable menu 
help. Menu help is a variant of Apple's balloon help, but it's 



not so annoying because Bernie activates it only when you 
have opened a menu. These messages can be actually very 
helpful when you are new to Bernie. We strongly 
recommend you to play with Bernie with menu help enabled 
for a while.

Join the mailing list or surf the online archive of past 
messages. You will find answers to many intricate questions 
here.

We are - as time permits - chatting in Delphi's Apple II 
Forum. We can work out problems there very quickly in a 
live conference.

Last but not least, we have the tech support line where a 
bunch of totally relaxed people will take your mail and 
answer whatever questions you might have, such as if I've 
been finally elected CEO of Apple Computer or not. Please 
note that we have put together some reminders that you 
should please read carefully before contacting us. This 
saves both of us time and makes correspondence much 
more fun. Thank you!

Audio/Video

1. Video Support

1.1 Power Mode
1.2 The Preferences

1.2.1 Screen Refresh
1.2.2 Switch Screen Depth at Startup

1.2.3 Bypassing QuickDraw
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2.3.3 Sound Capture Errors

2.4 Recommendations

1. Video Support

Bernie supports the entire range of video modes the Apple 
IIgs offers, and that's a lot. Video modes range from low 
resolution graphics and text modes to Apple IIgs' super-hires 
mode.

Different Video Modes

Bernie is offering three video modes: window mode, 
zoomed and Power Mode. In window mode, the Apple IIgs 
video display is contained in a single window and you can 
work with other windows and applications at the same time. 
In zoomed mode, the video window is shrinked. Lastly, in 
Power Mode the Apple IIgs video will occupy the entire 
screen and your Mac looks like a Apple IIgs.

Different Colors

Your Mac can run at different color "depths": 256 colors, 
thousands of colors, millions of colors, etc. Bernie has been 
optimized to run in 256 colors and 16-bit color depth 
(thousands of colors), and you might want to take 
advantage of this capability. (It's even a good idea to tell 
Bernie to switch to 256 or thousands of colors automatically 
at launch time.) You can still run Bernie at any other color 
depth, but it will run slower.
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Different Refreshes

Bernie is refreshing the video window at 15Hz, 30Hz or 
60Hz. There's also an "auto" setting where Bernie will find 
the best refresh rate for you. An Apple IIgs has a refresh 
frequency of 50 or 60 Hz, but this is often too often for most 
work. By reducing refresh frequency, you can free a lot of 
resources for improved performance.

1.1 Power Mode

Bernie features a special video mode called Power Mode. 
Power Mode makes your Apple IIgs emulator look like an 
actual Apple IIgs. The Power Mode has the following 
characteristics:

if possible your monitor will be set to 640x480 or 800x600 
(with extended border option)

the video window will be centered and the space around the 
Video will be covered by a border

Power Mode switches to 256 or thousands of colors and 
enables a fast video blitter for best performance

low-level mouse support is activated automatically
To activate Power Mode, push Command-Shift-F or the 
function key F8.

With the introduction of Bernie 3, you may make the 
regular mouse and menu bar temporarily available by 
holding down the Shift and Command keys.

In Power Mode, all available colors are reserved for IIgs 
video. Unfortunately, this prevents Bernie from displaying 
the border in the proper color. Bernie allows you to put aside 
one color for the border (see video panel in Preferences). Of 
course, this one color will not be available in the video 
window and may result (in extremely rare situations) to 
cosmetic quirks.

To quit Power Mode push Command-Shift-F or F8 again. 
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You have to remember this keystroke because the menu is 
not visible. Alternately, you can use the function key F8 to 
enter or leave Power Mode.

Displaying Aux Windows in Power Mode

Starting with version 3, it is now possible to have the Disks, 
Joystick and Sound windows displayed in full-screen mode. 
The windows will be shown at the bottom of the screen. You 
can swap the aux windows in and out by selecting the 
corresponding menu items from the Windows menu.

Tip: holding down shift and command reenables the Mac 
mouse. You can then click into the aux windows to configure 
various sound and joystick settings and eject mounted 
disks.

Switching to the Finder

If you just want to quickly dive into the Mac Finder and 
return to Power Mode later, use the shortcut Shift-F8. This 
command puts Bernie into the background and makes the 
Finder the active application. When you return to Bernie (for 
example, by choosing it in the applications menu), you'll find 
yourself back in Power Mode.

Important: remember that Bernie can be taught to emulate 
in background. If you're hiding Bernie with Shift-F8, it might 
still be running and other application may perform sluggish. 
To turn it off, check the flag "pause emulation when in 
background" in the Preferences.



1.2 The Preferences

Many settings can be controlled through the Preferences 
window. To open it, choose "Preferences" from the Setup 
menu:

Each option will be discussed hereafter.

1.2.1 Screen Refresh

The screen refresh rate controls how often Bernie is 
redrawing the video window. A Apple IIgs is updating the 
video sixty or fifty times a second (60Hz/50Hz), but usually it 
is not necessary to redraw the video window that often. By 
choosing a slower refresh frequency, you can free 
considerable resources and make Bernie run faster.

The exact overhead of screen refreshes is not fixed but 
depends on the software you are using. That's why Bernie is 
offering a "Auto" setting: it then chooses a refresh frequency 
that your Mac can handle without being slowed too much 
which is usually 30 Hz.

The recommended setting is "Auto" or "30Hz".

1.2.2 Change Screen Depth at Startup

Switches your main monitor to a color depth for which 
Bernie has a direct video blitter. Drivers exist for 256 colors 
and thousands of colors.

When launching Bernie and your video is currently set to 
anything below 256 colors, Bernie will switch to 256 colors. 
If video is set to millions of colors, Bernie will switch to 
thousands of colors.

Please note that the 16-bit blitter is not as fast as its 256 



colors counterpart. Running Bernie in thousands of colors is 
very, very approximately 5 to 15% slower.

The recommended setting is to have Bernie switch to an 
accelerated video mode.

1.2.3 Bypassing QuickDraw

Bypassing QuickDraw means that Bernie is directly writing 
into the video window on screen.

The conventional approach is to write changes to a separate 
memory area and then copy the new content to the video 
window, but this is slow. That's why Bernie is offering you to 
directly update the video window.

Note: Bernie can only bypass QuickDraw when the video is 
entirely visible and not overlapped by other windows, 
partially off-screen or crossing two or more monitors.

The recommended setting is to bypass QuickDraw.

1.2.4 Smooth Mouse Tracking

By default, Bernie is updating internal mouse parameters 30 
times per second. This is sufficient for most software and 
reduces mouse emulation overhead. If your software 
requires a finer resolution, you can tell Bernie to check the 
mouse position more often (60 times a second) by checking 
this box.

The recommended setting is to disable smooth mouse 
tracking.



1.2.5 Extended Border Area

The Apple IIgs monitor had a pretty large border 
surrounding the actual content. If you'd like to really feel at 
home, enable Extended Border to increase border size to 
about the size of an original Apple IIgs system.

Note: Extended Border should not be enabled on monitors 
with a resolution of less than 800x600 pixels because it 
exceeds the size of the monitor and is slowing down 
emulation. Power Mode will automatically disable Extended 
Border if your monitor does not support the minimum 
resolution of 800x600 pixels.

The recommended setting is to turn off extended border.

1.2.6 AppleColor™ Mode (Smoothed)

In AppleColor™ mode, Bernie smoothes 640x200 
superhires video display. This eliminates stripes but some 
elements (notably text) might look fuzzy. Enabling 
AppleColor™ mode does not affect any other video mode 
besides 640x200 superhires.

The recommended setting is to turn off AppleColor™ mode.

1.2.7 Power Mode: Switch at Startup

Automatically switches to (full-screen) Power Mode when 
Bernie is launched.

1.2.8 Power Mode: Preserve Border ColorPuts aside 
one color for the border color. This one color will not be 
available for superhires and theoretically can lead to 
cosmetic quirks. In practice, though, this should never 
happen.
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1.2.9 Power Mode: Fade Screen at Switch

Yet another check box in the same video panel, "Fade 
Screen at Switch", introduces a supercool fade out/in while 
switching between normal (windowed) view and Power 
Mode.

1.2.10 Power Mode: Change Screen Resolution at 
Switch

When switching to Power Mode, you can tell Bernie to set 
your monitor to 14" resolution. If your monitor does not 
support 14" resolution, this option does nothing.

Bernie requires QuickTime to be installed, otherwise 
switching resolution is not supported. If QuickTime is not 
installed or deactivated, Power Mode will simply stay at 
whatever resolution it is.

Another limitations are tabbed windows in MacOS® 8. For a 
yet to be found reason, MacOS 8 messes up the positions 
of popup windows when switching to 14" resolution. This 
problem does also occur when letting Bernie do the switch. 
There's nothing we can do about tabbed windows - we feel 
that's Apple's job to fix.

1.3 Copying Content of Video Window

Bernie lets you copy the content of the Video window in two 
ways, either as a bitmap or as a stream of ASCII characters.

The Copy command in the Edit menu automatically chooses 
the proper action: if the IIgs is in graphics mode, it copies 
the window as a bitmap, otherwise as text. If you are not 



happy with how the Copy command works, you can force 
Bernie to copy the text screen as a bitmap by choosing 
"Copy Graphics" from the Edit menu.

1.4 Video Performance Tips

With so many options it's easy to make Bernie dog-slow. 
Here's a short summary of what you should consider if 
you're looking for top performance:

switch your computer to 256 colors. This is the most 
important and simple tweak.

be sure the content of the Video window is entirely visible 
and not overlapped by other windows. (The window 
border may be hidden.)

turn off Smooth Mouse Tracking
go into Power Mode. Enabling Power Mode ensures all of 

the above performance tips are followed.

2. Ensoniq Sound Emulation
Bernie features the most advanced sound synthesizer of all Apple II 
emulators. It's 16-bit , 22/44kHz sound engine produces mono, 
stereo, stereo enhanced and Dolby Surround Pro Logic® output 
with a minimum of CPU resources. Internally, a non-linear, 
autobalancing synthesizer takes care of down-mixing up to 32 
voices at highest fidelity across all Ensoniq loads. Several 
optimizations including SonicSense and real-time smart voice 
cancelation ensure available CPU time is spent where it's needed, 
and additional goodies such as recording to file and a high-tech 
sound window complete Bernie's sound support.

Getting Help

If you have questions regarding Video support, feel free to go to the 
Feedback page and submit us your question or comment.
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2.1 Sound At A Glance

Bernie ][ The Rescue supports the full range of "sound 
reproduction". It supports so-called classic "1-bit" sound found in 
older Apple II programs as well as the Apple IIgs' Ensoniq® sound 
chip.

2.1.1 Turning Sound On/Off

Sound emulation is enabled by checking the menu item "Sound 
Support" from the Setup menu. When sound emulation is started, 
you hear a chime.

2.1.2 SonicSense: Saving CPU resources

Sound emulation requires a tremendous amount of CPU resources 
because the Macintosh does not have a dedicated sound chip but 
does all sound synthesis in software. 680x0 Macintosh systems had 
a sound ASIC or a DSP coprocessor, but all PowerPC-based Macs 
lack such a coprocessor.

Thus, Bernie gives you a helping hand. It features SonicSense, a 
technique for enabling sound automatically when software starts 
playing sounds and turning it off when the virtual sound chip is idle. 
To enable SonicSense...

open the Preferences window (see Setup menu)
click the Sound panel
check the SonicSense option
SonicSense is only active when both sound emulation is turned on 
and SonicSense is enabled. If you have disabled sound emulation, 
Bernie will not play anything.

2.1.3 The Sound Window

Just for your very own enjoyment, we have given Bernie a 
multifunctional sound window where you can watch sound 
emulation at work. The window includes an oscilloscope and a bar 
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of LEDs that represent oscillator activity, among others. It also 
allows for basic configuration of the sound engine.

Let's go through the window from the left to the right.

The first element is the master level meter - one for the left (L) and 
one for the right (R) channel.

The LED matrix in the middle of the window displays the activity of 
each of the 15 voices. (There are 32 voices, you may ask. That is 
correct, but they are almost always bundled in pairs as independent 
16 voices. One voice is typically put aside for timing, hence the 15 
voices display in Bernie.) Each column shows the activity of a single 
voice. The position of the indicator represents the volume of that 
particular voice.

Next to the LED matrix is a numeric indicator which is typically set 
to 16. The Ensoniq sound chip can be configured to serve less than 
its maximum of 16 voices (=32 oscillators). For example, you can 
choose the number of active voices in Diversi Tune.

To the right you see five loudspeakers centered around a point. 
Please take no offense, but the blotch is you. Depending on the 
currently active sound mode (mono, stereo, stereo enhanced, 
surround), the speaker symbols are on or off.

There are three remaining indicators at the top of the window. Their 
meaning is:

ON: sound emulation is enabled.
MUTE: sound emulation is disabled. No audio will be produced. 

Instead you will see an amazing Nite Rider™ light bouncing 
around.

STNDBY: SonicSense kicked in and turned off sound emulation 
temporarily because the sound chip was idle. Sound support 
will be reenabled automatically as soon as the software is 
playing through the Ensoniq again.



While this window is sometimes cool to look at, close it if 
you're done with it. The Sound window consumes an horrible 
amount of CPU resources. If you have a faster Mac (250Mhz or 
more, ballpark), this shouldn't be of much concern. On slower Macs, 
however, it will make a difference.

Clicking Your Way Through The Sound Window

The sound window allows you to configure essential sound settings. 
These include:

volume
sound mode
sound on/off
matrix display

To set the volume, click into the master level display. Your click 
must go into one of the four lower bars. (This is a feature and not a 
bug: the idea is to avoid accidential clicks into the higher volumes 
that may nuke your expensive loudspeakers.) Once you picked up 
the LED indicator, hold down the mouse button and set the volume 
to your needs. Emulation will continue in the background so you 
can adjust the volume with "live" feedback.

Please note that any volume level beyond the lowest possible 
setting may lead to distorted sound due to clipping. When you hear 
scratches, you should consider reducing the volume and increase 
your Mac's global sound volume instead.

Also note that the Sound Window volume "slider" does not offer the 
same resolution as its counterpart from the Preferences window. 
You can fine-tune the volume much better from within the 
Preferences window.

To change sound mode, click into the group of speaker icons to 
the right. Depending on the icon onto which you click, a different 
sound mode will be chosen.

Lastly, clicking either the "ON" or "MUTE" indicator toggles sound 
support.The LED matrix is a multi-purpose display. You can rotate 
through 3 different pages by clicking the two digits ("16" in the 
illustrations above):



The first page, recognized by a decimal number (typically a 16), 
shows the oscillator activity. Each column represents a 
single Ensoniq voice. The vertical range is the oscillators' 
output volume.

The second page, labeled "SP", consists of a spectrum analyzer. 
The leftmost bar displays the lowest bands (around 80 Hz) and 
so forth. Note that the spectrum display is backed by very, very 
time-intense math routines. We do not recommend running the 
spectrum analyzer on slower Macs.

The third page (marked with a "Fr") shows in what frequency band 
each oscillator is playing. (Note: the frequency at which an 
oscillator is running is independent of the actual output 
frequency of an audio wave. If you're interested in actual 
output frequency, you need to go with the spectrum analyzer.) 
The frequencies displayed here are internal Ensoniq 
parameters.

Configuring the sound engine by clicking into the sound 
window is also supported in full-screen mode. Holddown 
command-shift (to make the mouse pointer appear) and change the 
settings to your needs.

2.2 The Sound Preferences

2.2.1 Playback Mode

The playback mode lets you choose among various settings.

Mono outputs a mono signal and is the fastest mode requiring only 
a fair amount of CPU resources.

Stereo provides you with a stereo output if your Mac can reproduce 
two channel sound.

If you are connecting headphones, we recommend you to choose 
Stereo Enhanced - this mode reduces the stereo effect for 
more relaxed listening with headphones.

Dolby® Surround is Bernie's state-of-the-art surround sound 
engine. If you have your Mac connected to a Dolby® Pro 



Logic/THX® decoder/preamplifier, this mode outputs 4 channel 
surround sound (left, right, center, rear). Unfortunately, in order 
to hear sounds on the center and rear channels, Apple IIgs 
software must be capable of addressing more than just the 
standard two stereo channels. See below for information on 
"Rear Channel Automapping".

VectorSound modes are high-precision stereo playback modes. 
They come with enhanced accuracy and real-time audio filters.

The recommended setting is mono for best performance or stereo 
for games and music applications. Use VectorSound for high-fidelity 
music applications.

VectorSound™ Sound Modes

Besides the usual suspects mono, stereo, stereo enhancement and 
surround playback mode, the new VECTORSOUND engine comes 
in various flavours.

VS™ Direct: this mode selects the new, high-precision sound 
engine. This mode comes close to regular stereo mode but is 
even more accurate than the already improved mono or stereo 
modes. This is the fastest VECTORSOUND mode and the 
recommended choice for gaming and listening to lower-quality 
sounds (such as MODs) or voices. VS Direct produces really 
crisp audio.

VS™ Interpolated: the linear sound mode adds very limited bit 
enhancement that actually may lead to a noticeably dampened 
sound. It's almost as fast as VS Direct, though, which may be 
the only reason why it's there. Ahem. :-)

VS™ Harmonic: Bernie's Harmonic mode smoothes a wave very 
accurately. Unfortunately, there's an awful lot of math required 
for this, thus VS Harmonic is dog-slow. The resulting wave is 
supersmooth. The inherent drawback of VS Harmonic is that 
high-pitched sounds and noises can't be reproduced precisely. 
Thus, VS™ Harmonic works best with high-quality FM sounds 
such as those found in SynthLab. It's an experimental sound 
mode that may or may not cut it for you.

VS™ Harmonic Compressed: based on the Harmonic sound filter, 
the compressed flavour greatly reduces the effects on high-
pitched sounds. It's a compromise between Direct and 
Harmonic modes.



2.2.2 Volume Amplifier

The Volume slider lets you amplify sound.

If you increase volume beyond the "Normal" setting, you 
may experience audible scratches in some situations. 
Amplifying the volume basically says that you are increasing 
volume beyond what's mathematically correct, so scratches 
are necessarily part of the process.

The recommended setting is to set volume to normal. Some 
software is playing at a very low level (for example SynthLab) and 
may need to increase volume.

2.2.3 Extra Features

The Extra Features are a collection of unique functions that improve 
sound quality:

Crisp 44kHz Hi-Fi sound lets you choose between 22kHz (off) and 
44Khz (on). 44kHz produces crystal-clear output but also 
doubles the amount of audio data. If your computer is short of 
CPU cycles or you are recording to disk, downsizing sound to 
22kHz is an option you should consider.

Rear Channel Automapping screens the sounds played through 
the Ensoniq and dynamically maps certain voices to the rear 
and center channels. This option is only active when used with 
Dolby Pro Logic sound mode. It allows you to listen to 
surround sound even if the Apple IIgs software is designed to 
play stereo only. This is an experimental feature and may not 
always produce 'good' sound. Check it out! 

High-Precision Timing is a new feature for audiophiles. With this 
option Bernie will dedicate more resources to sound emulation 
which allows the emulator to make the timing more accurate. 
Of course there's a trade-off between accuracy and emulation 
speed, especially on slower Macs. We do recommend High-
Precision Timing for use with music applications and games. 
You should disable this feature when recording to disk.



2.2.4 Optimizations

The Extra Features are a collection of unique functions that improve 
sound

Smart Voice Cancellation is a technique for cutting down the 
number of redundant voices. Enabling it reduces overhead 
without sacrificing quality.

SonicSense is a special feature that cuts down sound emulation 
overhead to an absolute minimum. You should always enable 
SonicSense. Basically, it means that sound is turned off 
automatically after 2 seconds of silence and restarted when 
sound resources are being used again. When sound is turned 
off by SonicSense, the red light in the "Sound" window is 
blinking.

2.3 Sound Capture

2.3.1 Using Sound Capture

Sound Capture is a feature that lets you save audio to a Macintosh 
sound file. The resulting file is a QuickTime AIFF document that you 
can open in QuickTime Player or virtually any sound editor for 
further processing.

To start sound capture, open the Edit menu and select "Capture 
Sound...". Bernie asks you for a file name and where to save the 
file.

To stop sound capture, select the same menu item again.



2.3.2 Performance Considerations

Recording sound to a file involves quite some action, and slower 
Macintosh systems may not keep up with the data stream. To give 
you better control over sound recording, here are some technical 
details that will allow you to better configure Bernie's sound capture 
feature.

Sound recording is always done in the current sound mode. The 
sound mode is a combination of mono/stereo and 22/44kHz HiFi 
sound. (Stereo includes stereo enhanced and surround sound. 
Bernie does never record in VectorSound mode but switches back 
to regular stereo for performance reasons.) Depending on the 
combination of the two factors, the data volume can quadruple in 
worst case. To give you a better understanding of the amount of 
data, here're some figures for a 1-minute recording:

22kHz, mono: 2.5 Mb (43 kB/second)

22kHz, stereo: 5 Mb (86 kB/second)

44 kHz, mono: 5 Mb (86 kB/second)

44 kHz, stereo: 10 Mb (172 kB/second)

The higher throughput is the more likely is the chance of dropped 
frames. A dropped frame is a chunk of audio data that was 
generated but couldn't be written to disk because the previous 
frame was still waiting in the queue. If you are experiencing a lot of 
dropped frames, you should consider switching from 44kHz to 
22kHz or from a stereo mode to mono.

Another, very important influence on your system's ability to keep 
up with the data stream is the High-Precision Timing option. As 
mentioned earlier, this feature sacrifices valuable CPU resources 
for increased accuracy. Even on faster Macs the data flow 
generated by high-bandwidth sound modes (44kHz stereo) and the 
immense overhead of High-Precision Timing can lead to dropped 
frames. Therefore, we recommend to turn off High-Precision 
Timing while a sound capture is in progress. Your Mac is given 
more time to process the sound data without giving up sound 
quality.



2.3.3 Sound Capture Errors

Because Sound Capture really dislikes shortages in CPU cycles, 
you are given a detailed summary upon stopping a recording. When 
all went smoothly, Bernie displays the following message in the 
status bar:

All data has been recorded successfully.
That's the message we're all looking for. In some situations, 
however, dropped frames occured and Bernie posts a message to 
the Error window:

Some data was lost (99% written).
This message means that a very small fraction of the sound data 
could not be recorded to disk. Actually, you shouldn't worry about a 
result of 99% as a dropped frame or two can easily occur during the 
very beginning of the sound recording process. (The MacOS gets a 
hiccup when creating the file and updating the Finder window or 
desktop. Chances are almost 50-50 it drops a frame at that time.)

A more worrying error message would be:

Some data was lost (50% written).

This typically happens when your Mac is technically not able to 
record at the pace you chose. In this situation you need to...

if applicable, record to a faster storage device or RAM disk.
quit background applications and close Finder windows
disable High-Precision Timing
switch from 44 kHz to 22 kHz
switch from stereo to mono
We recommend that you proceed in this order.

Things are different when dropped frames were caused by a disk-
related error. There are a number of potential problems that can 
happen when a software is writing to disk, and Sound Capture is no 
exception. Typical errors are disks with not enough free space or 
when Bernie was not given write access. If a disk error occured, 
Bernie will post an additional error message to the Error window 
indicating why the file could not be written properly

.
Due to the way how Sound Capture is wired internally, Bernie can't 
stop Sound Capture by itself. So when a disk error or dropped 



frame occurs, Sound Capture will continue even when no sound 
data can be written because of a filled hard disk or the like. It's 
therefore a good idea to double-check storage space and make 
sure everything's settled for Sound Capture.

2.4 Sound Performance Tips

Sound emulation may slow down Bernie on low-end Power Macs 
significantly. For best performance, be sure to:

enable SonicSense and Smart Voice Cancelation
use Mono playback
disable High-Precision Timing
we have found that Macs are somewhat faster when the Mac (not 

Bernie!) is set to 44kHz: open the Sound control panel and set 
"Sound Out" to 44Khz.

the Sound window (see Window menu) displays some fancy 
controls. However, opening this window eats valuable CPU 
resources, so better close it when speed is critical.

some music applications provide options for reducing the number of 
active voices
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1. Introduction
Emulators have a problem - they are emulating a particular machine 
in software but do not have access to the peripherals the software 
is expecting. Thus, emulators such as Bernie ][ The Rescue have to 
find alternate ways for retrieving and storing information.

Luckily, the Apple IIgs and Macintosh share many hardware 
components, and Bernie does a good job of bridging technical 
differences. This chapter explains how Bernie can work with your 
software archive via the built-in disk drive (hereafter referred to as 
the "SuperDrive"), shared volumes and disk images.
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Overview

The chapter 2 in this document describes the different types of 
"disks" (physical disks, virtual disks, shared volumes), how you can 
create a new virtual disk, share a volume and what disk formats are 
supported.

Next, we'll elaborate on the Cleverport interface, a custom disk 
controller that is fast, flexible and gets the job done. About 95% of 
Apple IIgs software is compatible with the Cleverport. It does not 
emulate the underlying hardware but rather intercepts calls to the 
Firmware. The advantage is that this is really fast and proven. 
Cleverport has been part of Bernie since its introduction and is the 
default "disk environment".

The fourth chapter describes the Intricate Whirl Machine (IWM) 
that substitutes Cleverport. The Intricate Whirl Machine is emulating 
Apple IIgs disk hardware on the lowest possible level and allows 
you to run those very rare titles that refuse to work with the 
Cleverport. The IWM requires some technical understanding 
(notably how drives are mapped), but it's operating transparently 
and hides its technical nature from the user. We recommend you to 
stick with Cleverport unless you want to run some software where 
IWM emulation is mandatory.

The fifth section discusses support for 5.25" disk images, i.e. what 
images are supported and how you can manage them.

Another chapter in a separate document explains disk 
preferences, a real time-saver for advanced Bernie users. Disk 
preferences allow you to define certain settings for individual disk 
images and activate them when booting from them.

Getting Help

If you have questions regarding storage, feel free to go to the 
Feedback page and submit us your question or comment.
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2. Real, Virtual And Shared 
Disks

Bernie supports a variety of disk formats, from physical 3.5" disks to 
volumes that appear on your Mac desktop. For each type there's a 
lot of information to share with you, so let's start. The following 
subchapters discuss each disk type.

2.1 The SuperDrive

A wonderful thing is that Macs and IIgs computers have the same 
3.5" disk drive in common. This enables Bernie to read disks that 
were created on a IIgs.

Bernie is compatible with HFS, ProDOS (GS/OS) and MS-DOS 
disks. It can read from and write to physical 3.5" disks. Bernie does 
not require PC Exchange or File Exchange (MacOS 8.5) for reading 
ProDOS disks.

2.2 Virtual Disks

Virtual disks seem to be a confusing concept for users new to 
emulators. Understanding how virtual disks (or disk images) work is 
essential because they offer unique advantages.

A virtual disk is a file on one of your Mac volumes that appears as a 
disk in the emulated Apple II. Apple II software is seeing this disk as 
a disk inserted into a storage peripheral because the emulator 
mimics the hardware of such a drive. In reality, Bernie intercepts 
read/write commands to this virtual device and translates them into 
read/write commands to a file on a Mac volume. Thus, all accesses 
to this drive are affecting the Macintosh file. The files are therefore 
called "disk images" or "virtual disks".



As with real disks, disk images have to be inserted and ejected. 
Instead of "inserting" disks, making a disk image available is 
referred to as mounting a disk image.

Disk images can be of almost any size and come in different flavors, 
i.e. formats. Bernie supports different formats. Except for the 
Universal Disk Format (also referred to as "2IMG" format), none of 
them offers a particular advantage over others. They are supported 
because these already exist or because they can be further used 
with other tools such as disk copiers. Bernie supports:

"DiskCopy" : Disk Copy is a popular disk copier from Apple 
Computer. You can turn "real" 3.5" disks into disk images using 
Disk Copy and directly use the resulting disk image with 
Bernie. Bernie supports DiskCopy 4.2 and DiskCopy 6 images, 
except for DiskCopy 6 compressed images. They will not work.

"Universal Disk Image" (2IMG): There's a new disk image format 
that will work with most regularly updated emulators across all 
platforms. Bernie can create, read and write such images. 
These images can also contain emulator-specific 
enhancements and user comments, though these features are 
not yet supported by Bernie. For compatibility reason, we 
recommend you to use this type.

"Hard Disk Image": A less popular disk image. You will hardly use 
it, but it's nice to know Bernie can deal with it.

"Raw Data Image": A disk image format that does not have a 
header. It's merely a collection of disk blocks.

Bernie also supports 5.25" disk images:

ProDOS-order: disk images with a ".po" suffix have been formatted 
with ProDOS or GS/OS.

DOS-order: disk images with a ".do" suffix have been formatted 
with DOS 3.3.

Nibblized Data: disk images with a ".nib" suffix.

2.2.1 Creating a Virtual Disk

Creating a virtual disk is as simple as saving a file. To create a new 
image, follow these steps:



open the File menu and choose "Create New Disk..."
choose a disk image format, preferably "Universal Disk Image"
choose a size
give the new image a name and save it to a Macintosh volume
Done!

2.2.2 Automatic Initialization

Disk images created within Bernie using the "Create Disk.." 
command are initialized automatically with ProDOS®. This means 
you can create a disk image and it will be recognized immediately. It 
is not possible to initialize disk images with DOS 3.3®.

2.2.3 Mounting Disk Images

To mount a disk image, choose the "Mount Disk.." item from the 
"File" menu. This opens a standard file dialog where you can pick 
your disk images.

Please note that there're a number of shortcuts that simplify disk 
mounting significantly. These shortcuts - drag & drop mounting, 
recently mounted disks list, and the Disks' window button bar - are 
explained thoroughly in chapter 3.

2.2.4 Mounting Multiple Disk Images With MacOS 8.1 or 
Earlier

With Bernie, you can put disk images that somehow belong 
together into folders and mount them all at once. To do this, click 
again the Mount button in the Disks window or choose "Mount 
Disk.." from the File menu. A dialog box appears:

In the illustration above, a folder has been highlighted. By pushing 
the Accept button, you tell Bernie to mount everything in that 
folder.

Please note the stress on "everything". Since disk images often 



have invalid file types (due to downloading etc.), Bernie really tries 
very hard to mount as much as possible. If you have other files in a 
folder, Bernie would look into each file and display an error 
message for each file that is not a disk image. Thus, please mount 
only folders that only contain those disk images you want to mount.

Besides mounting each file, Bernie will also verify if each disk 
image has the proper type. If not, it "auto-types" disk images so 
they will show up properly the next time. This is all done 
automagically in the background.

2.2.5 Aliases Of Disk Images

Bernie properly resolves aliases to disk images. You might want to 
use aliases for creating worksets - folders with disk images 
belonging together while keeping the original disk images in their 
place. For example, you could store aliases of a GS/OS system 
disk and your favorite GS/OS application in one directory.

2.3 Shared Volumes

Volume Sharing basically means that you can mount any volume 
seen in the Finder also in the Apple II environment. This applies to 
ProDOS volumes (mounted with PC Exchange or other third party 
tools), HFS volumes (MacOS), MS-DOS volumes and CD-ROMs. 
You can only mount the first session of a multisession CD-ROM.

Volume sharing has one pretty steep requirement - the volume 
you'd like to share must appear on the Mac desktop first. While this 
doesn't sound too difficult, it often is because ProDOS support on 
the Mac is a rather dark chapter. Here's a short summary which 
tools might help you:

PC Exchange is the best choice if you are owning an original 
Apple hard disk with standard Apple partitioning. If you are 
using third-party drives or have reformatted your hard disk for 
use with RAMFast, PC Exchange won't work.

FWB's Hard Disk Toolkit is a killer SCSI toolkit for techies. It's 
complicated but incredibly powerful. You can mount ProDOS 
volumes with great success. Unfortunately, FWB nuked 



ProDOS support in version 2.x, but even recent versions 
reportedly still feature ProDOS support (though FWB is 
denying it.) There're some caveats with FWB's Hard Disk 
Toolkit - see next section.

SilverLining Light let's you mount certain ProDOS partitions, too. 
It's an utility from La Cie Inc.

Apple's Drive Setup utility also has a Mount option but refuses to 
work with non-Apple drives. Still, you can patch Drive Setup to 
work with other drives as well.

The SilverLining and Drive Setup options have been suggested on 
the Bernie mailing list - you might want to join the list for more 
information.

Volume sharing frees you from moving your data - for example from 
your former Apple II hard disk - to a virtual volume via 3.5" disks. 
You can access all data on a volume (some file system specific 
restrictions may apply) - easily and at pretty high transfer rates.

2.3.1 Sharing a Disk With MacOS 8.5

choose "Share Disk..." from the File menu
highlight a volume
push the "Choose" button

2.3.2 Sharing a Disk With MacOS 8.1 Or Earlier

choose "Mount Disk.." from the File menu
push the "Desktop" button to see a list of all available volumes
highlight a volume
set the check box "read-only" the the appropriate setting (see 

below)
click the button at the bottom that says "Mount <volume>" where 

<volume> is the name of the volume you selected.

Important: you can't share the startup volume. If you select the 



startup volume, the Mount button will be dimmed.

Tidbit

If you are familiar with ShrinkWrap, volume 
sharing can be an incredibly useful tool for 
transferring data even if you only have a 
single disk attached to your Mac.

With ShrinkWrap you can create disk images 
that mount just like real disks on the Mac 
desktop. You can copy data onto it and then 
tell Bernie to share the disk. Works like a 
charm.

To do so, launch ShrinkWarp (currently at 
version 3). Then choose the command "New 
Image" from the "Image" menu and create a 
new disk. ShrinkWrap will mount the image 
automatically so you can start using it 
immediately.

When you're done, go to Bernie and choose 
"Mount Disk.." or "Share Disk..." from the 
"File" menu. Share the disk as outlined above.

2.3.3 Read-Only or Read/Write Access ?

Below the Mount button is a checkbox titled "read-only". It is 
checked by default. This checkbox allows you to mount a volume in 
two completely different ways - it's not just that write access is 
enabled or not, instead there are some major differences in how the 
volume is mirrored in the Apple II environment.

If read-only is checked, the volume appears in the Apple II 
environment as a write protected Smartport device. Simultaneously, 
Bernie places a lock on the volume in the MacOS layer, thus 
preventing any modifications. (You will see a "lock" in the Finder 
windows.) Consequently, you have read-only access from both 
MacOS and the Apple II. When you unmount the volume in Bernie, 
the lock will be removed and you can read and write again from 



within MacOS. (Note: the Finder does not automatically update the 
Finder windows. Therefore, you might still see the disk lock even 
though it has been removed. Please close the Finder windows and 
reopen them to see the changes.)

If read-only is cleared, the volume will be removed from the 
desktop and Bernie is taking over control. Although this seems to be 
much cooler than read-only access, there are some important 
pitfalls you should be aware of:

Some FWB Hard Disk Toolkit (HDT) drivers are 
incompatible with volume sharing. This is a deficiency 
of the HDT driver. We have found that

all HDT drivers do not work on removable media with the 
"physical eject on unmount" flag checked. (This 
flag is in the HDT driver configuration. Please 
consult the manual for more details.) There are 
two workarounds: either disable "physical eject on 
unmount" or use a different driver.

HDT versions prior to v2.0 do not implement certain driver 
calls properly. You will not be able to use volume 
sharing with HDT versions predating 2.0 (whether 
the media is removable or not).

This information applies to you only if you are using the 
"Hard Disk Toolkit" software from FWB Inc.

Be very careful with HFS volumes. Even though GS/OS 
can access HFS volumes, the HFS driver in GS/OS 
is known to be very buggy and can corrupt a 
volume effortlessly. There are patches that fix 
some of the most annoying quirks, but you still 
risk loss of data. We recommend you to use HFS 
volumes only with dependable media or in read-
only mode. In read-only mode data on the shared 
disk can't be modified and you're on the safe side.

While the volume is controlled by Bernie in write-enabled 
mode, MacOS does not claim the volume is in use. 
Consequently, you could eject removable media easily 
and nobody would complain. DO NOT EJECT THE 
MEDIA. Instead, follow these steps:

shut down GS/OS or ProDOS 16 so all open buffers/caches 
are written to disk



unmount the volume in Bernie (push the "Eject" button)
the volume will reappear in the Finder. Drag it to the Trash.
As you can see, sharing a volume in read/write mode does not 
come for free. We have implemented the read-only mode for those 
who do not want to risk loss or corruption of data caused by 
components that are not necessarily under Bernie's control. After 
all, read-only mode is perfect for transferring huge volumes of data. 
Better safe than sorry!

2.3.4 Aliases Of Volumes

With Bernie, you can make aliases of volumes and mount the alias. 
Bernie will resolve the alias and share the volume.

Because volumes can be shared read-only or with full read/write 
access, the function of aliases has been extended:

if an alias is locked, the volume it is pointing at will be shared read-
only

if an alias is not locked, the volume will be shared read/write
Please keep in mind that sharing HFS volumes with full read/write 
access is not recommended.

3. The CleverPort™ Interface

The CleverPort is Bernie's proprietary disk interface. It's a substitute 
for SmartPort, a technology built into Apple IIgs computers. The 
SmartPort serves as a not-so-low-level interface for exchanging 
data in blocks of 512 bytes per transaction. CleverPort intercepts 
and interprets these command sent through the Smartport interface.

CleverPort emulates an imaginary device chain of up to 8 devices. 
Each device can hold one disk of virtually any size. It works with 
"real" 3.5" disks, virtual disks and shared disks equally well.

For the sake of simplicity, please make sure the menu item "Low-
Level Disk Support" in the Setup menu is disabled while working 
through this chapter. The exact function of this flag is explained in a 



more technical chapter about the "Intricate Whirl Machine IWM". 
Basically, you have the choice between running Bernie with 
CleverPort or with IWM emulation - they are mutually exclusive. But 
the question remains:

When Should I Use CleverPort?

Always use CleverPort except with very few software titles 
that refuse to work with it. These include some GS/OS 4.0 
disks and some self-booting demos. Almost all programs 
written with just the slightest intention of compatibility are 
compatible with CleverPort. CleverPort is faster and 
supports a much wider range of disk capacities than IWM 
emulation.

3.1 The Disks Window

The Disks window gives you control over the imaginary device 
chain. Upon launching Bernie, it looks more or less like the figure 
below:

3.1.1 The Built-In SuperDrive: Mounting a 3.5" Disk

The window contains only one device (drive) that is labeled "built-in 
SuperDrive" and resides at ID 2. A chain may contain devices from 
1 to 8 - in this case we only have this single device.

This particular drive is actually an exception because it is always 
mounted and visible. Whenever you stick a disk into your Mac's 3.5" 
disk drive, the disk you have inserted will be mapped to this unit. 
Analogously, if you'd like to eject a disk in the built-in 3.5" drive, you 
only need to tell Bernie to eject the media in the drive titled "built-in 
SuperDrive".

3.1.2 Mounting A Disk Image

Usually, you won't use real 3.5" disks that often because they are 

http://replay.web.archive.org/20010420161606/http://www.magnet.ch/emutech/Bernie/Documentation/Storage/storage.html#IWM
http://replay.web.archive.org/20010420161606/http://www.magnet.ch/emutech/Bernie/Documentation/Storage/storage.html#IWM
http://replay.web.archive.org/20010420161606/http://www.magnet.ch/emutech/Bernie/Documentation/Storage/storage.html#IWM


rather slow compared to disk images. Also, you can have only one 
single 3.5" disk online which restricts usage.

What you need is a drive that is loaded with a virtual disk. To mount 
a disk image, push the "Mount" button at the bottom and pick a disk 
image. (To learn more about how to create a new disk image, 
please turn to the chapter "Creating a Virtual Disk".) For the sole 
purpose of demoing how the window will look like, assume we have 
mounted a really large disk image titled "Games":

Bernie has created a device for this new image and mapped it to 
unit #1. Bernie will always map a new image to the lowest-
numbered free unit. Next to the drive icon you can see the disk 
image's name ("Games"), it's size and what kind of disk image it is. 
In the example above, Games is huge disk image with 32 Mb worth 
of data. If we mounted more images, the window would grow in the 
following way:

(Please ignore the small "I" and "II" boxes. Their use will be 
explained in chapter 4.)

3.1.3 Mounting Disks & Volumes By Drag & Drop

Picking disk images and volumes from standard "File Open" dialog 
boxes can be tedious. That's why Bernie allows you to grab disk 
images from the Finder and drop them onto the Disks window:

locate a disk image, volume icon or alias
click it and hold down the mouse button
drag the icon to the Disks window
while the cursor is on top of the Disks window, you will notice a very 

faint blue border
release the mouse button
When mounting volumes that way (i.e. when sharing volumes by 
drag&dropping their icon), the volume will always be mounted in 
read/write mode.

3.1.4 Mounting a Recently Used Disk Image or 
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Volume

Bernie keeps track of the last few mounted disk images and shared 
volumes. To see a list of recently used disks...

open the File menu and select a disk from the "Mount Recent" 
submenu

in the Disks window, push the Mount button and hold down the 
mouse button until a popup menu appears

hold down the "Mount" button for apopup menu of recently used 
disks

3.1.5 Selecting/Deselecting a Drive

Suppose you want to do something particular with a disk image 
such as locking it, ejecting it, or whatever. To select a target device 
for these actions, click once on a device so that it becomes 
highlighted:

If there's a selected device, all of the buttons at the bottom are 
active.

To deselect it, click it again.

3.1.6 Ejecting a Disk

Unlike Mac 3.5" drives, 3.5" drives for the IIgs feature a "manual 
eject" button for ejecting disks. So does Bernie.

Before further elaborating on how to manually eject a disk, let's start 
with a very important warning. Ejecting a disk makes the volume 
unavailable. If, for example, you are ejecting a disk while Apple II 
software is still writing to a disk or has still buffers to be flushed, the 



ejected disk may be severely corrupted because not all data could 
be written to disk. To prevent corruption, please keep this in your 
mind:

if possible, always let the system software eject a disk. For 
example, when you're in the Finder move the disk to the trash.

if you are not sure if all caches have been flushed, quit the current 
application or shut down the virtual IIgs properly

Basically, Bernie does not introduce any additional "catches". These 
rules are valid on any system with removable media.

Actually, there are four different ways of how to manually eject a 
disk. Each works equally well:

select a drive, then push the green EJECT button at the bottom of 
the Disks window

each drive has its own eject button. Push to the right of the disk slot 
to eject a disk.

open the Setup menu and the Eject Disk... submenu. You can either
choose Eject More to select multiple disks and eject them at once
choose a particular drive, identified by its unit ID

3.1.7 Locking/Write-Protecting a Disk

Bernie also allows you to "soft-lock" a disk image. The image is not 
physically locked, but Bernie pretends it is. Apple II software is 
unable to modify the content of software that operates on a disk 
(image) with a soft-lock.

Note: in some situations a disk is always locked, and you 
can't do anything about that. This happens when you are 
mounting disk images who have been locked in the MacOS 
Finder, or shared volumes in read-only mode.

To lock a disk, do this:

select a target drive
push the green LOCK button at the bottom of the Disks window
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3.1.8 Rearranging the Device Chain

Up to now you have seen how to mount additional disks by using 
the Mount function. New disks have been added by creating a new 
drive at the lowest-numbered free slot. It is possible, however, that 
you'd like to mount a disk at another ID. For example, the unit ID is 
indirectly determining from which volume will be booted and at 
which slot/drive combination a disk resides. (More about booting 
under Cleverport in the next chapter.)

To move a disk to a new (free) unit, follow these steps:

select a target drive
push the up or down arrow buttons to move the drive to the next 

higher or lower free unit
(Note: the arrow buttons are at the bottom of the Disks window. The 
arrow keys on the keyboard do not work here.)

Note that the arrow keys move a drive only from one free unit ID to 
the next. Example:

In this example, drive #1 hopped to the next higher free unit which 
is unit 3. ( If you pushed the up arrow again, it would hop on to unit 
6.)

Warning: remapping a drive may severely confuse the 
system software. Furthermore, if there are still disk caches 
with data not written to disk, the disk image may become 
corrupted. We strongly recommend you to remap devices 
only during startup, after shutdown, or while working with 
ProDOS 8. For the system, remapping is basically the same 
as ejecting a disk, so the same warnings apply here.

3.2 Booting With CleverPort

When Bernie reboots with CleverPort enabled, it first determines 
which drive to boot from. It does this by first inspecting the unit #1, 
and if this drive does not contain a bootable disk or is empty, 
advances to unit 2 and so on. Once it finds a bootable disk, it 
moves it down to unit 1 because this is the drive Bernie does 
always boot from. In case unit 1 was already occupied by a non-
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bootable disk, Bernie simply swaps unit 1 with the first bootable 
disk.

Consider this situation:

When you boot Bernie with CleverPort, it first checks units 1 and 2. 
Since both units are empty, Bernie proceeds with unit 3 where it 
finds a bootable disk ("Sword of Sodan" - don't ask for it, it's only 
the demo version :-) .) Hence, it moves "Sword of Sodan" down to 
unit 1 and boots from it.

(If there were another disk at unit 1, Bernie would have moved it to 
unit 3.)

3.2.1 Manually Adjusting Boot Order

With this knowledge you can choose any boot order you wish. Just 
make sure the disk you want to boot from is the first bootable disk in 
the device chain. It needs not be at unit 1 but may not be preceded 
by another bootable disk.

For example, if you'd like to boot from the volume "Games" in the 
right illustration above, you would have to move "Sword of Sodan" 
one place up (to unit 3) and move "Games" down to unit 1.

Here a brainteaser for techies: you could also move "Games" down 
to unit 3 first and then move "Sword of Sodan" up. "Sword of 
Sodan" would then be reassigned to unit 6. Bernie would still see 
"Games" as the first bootable device and move it to unit 1 
automatically. Hooray!

3.3 Declaring Default Startup Disks

After spending some time Bernie, you will eventually find that you 
are mounting the same boot disk with every new Bernie session. 
Luckily, you can tell Bernie to automatically mount one or several 
disk images every time Bernie is started.



When opening the Preferences window and choosing the "Storage" 
panel, you'll find a box where you can define your startup disks. To 
pick your startup disks, push the button "Select Startup Disk or 
Folder".

As with mounting disk images, you may choose to either pick a 
single disk image or an entire folder. For more information please 
turn to "Mounting Multiple Images". (This also applies to MacOS 8.5 
and later.)

Lastly, the checkbox "Don't mount when starting with a disk 
image" deserves an explanation. It is possible to start Bernie by 
dropping a disk image onto Bernie's application icon, or by double-
clicking it. The latter is probably the way you're usually starting 
Bernie.

When starting Bernie with a disk image, you can tell Bernie whether 
you would like to load any startup disks plus the disk images you 
dropped onto the Bernie icon or just those you dropped. For 
example, if your startup disk is a GS/OS start disk and you're 
dropping your favorite, self-booting game onto the Bernie icon, you 
might not want to have the startup disk loaded. In other situations it 
might be still appropriate. This checkbox lets you configure Bernie 
to your requirements.

4. Intricate Whirl Machine IWM

Recent releases of Bernie feature IWM emulation for compatibility 
with very hardware-dependent software. These software titles "talk" 
directly to the hardware and require highly accurate emulation. IWM 
emulation replaces CleverPort, Bernie's proprietary disk controller 
that has been discussed in chapter 3.

When Should I Use IWM emulation?

IWM emulation has been streamlined to work with very 
hardware-specific software. It does not offer the flexibility 
and speed of CleverPort. However, it enables you to run 
software from the FTA and improves compatibility with copy-
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protected software (see below for more information).

Bernie's IWM emulation mimics the availability of the original disk 
controller in every Apple IIgs. Currently, IWM emulation is limited to 
up to two 3.5" drives that each can hold one disk of 800kB capacity.

Note: IWM emulation outlaws disks with capacities other 
than 800kB. This means that you can only use software that 
comes on 800kB disks or disk images. Although you can 
still mount disks of any size, Bernie will ignore anything but 
800kB disks while being in IWM emulation.

4.1 Enabling IWM Emulation

To enable IWM emulation, you have two possibilities

choose Low-Level Emulation from the Setup menu
in the Apple IIgs control panel, set Slot 5 to "Smart Port"
While choosing a simple menu command is rather straightforward, 
the latter point needs to be elaborated. The Apple IIgs offers a 
group of control panels that are either accessed by pushing 
Command-Control-Escape or by selecting "Control Panels" from the 
Apple menu. In either case, there's a "Slots" panel for configuring 
the slots in a Apple IIgs. Each slot can either take over a built-in 
function or activate the (external) card it is holding. In Bernie, this 
concept is used to switch between Cleverport (our proprietary disk 
controller) and IWM emulation, the built-in disk controller. Assuming 
that you have opened the Classic Control panels (push Command-
Control-Escape) and opened the Slots panel, you will see a screen 
like the one below:

If slot 5 is set to "Smart 
Port",

IWM emulation is active.

If slot 5 is set to "Your 
Card",

Bernie's proprietary 
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CleverPort interface is 
active.

Note: switching from IWM emulation to CleverPort or vice 
versa involves rebooting your virtual Apple II. You can 
change the settings any time but they won't take effect until 
you reboot

If you are unsure whether IWM emulation or Cleverport is active, 
just have a look at the Disks window. The title bar indicates which 
component is currently running:

IWM emulation is active IWM emulation is inactive
In order to facilitate switching from IWM to CleverPort, Bernie now 
automatically enables CleverPort when there's no bootable 3.5" disk 
mounted.

4.2 Drive Mapping

As you have eventually noticed in the chapter about CleverPort, the 
device chain displayed in the Disks window sometimes contains 
small tags that look like this:

As noted earlier, IWM emulation is restricted to 2 3.5" drives. The 
Disks window, however, allows you to mount up to 8 disks of any 
size. Bernie thus has to find two disks in the device chain that are 
compatible with IWM emulation. The two drives that meet this 
criteria are marked with a "I" and "II" respectively.

4.2.1 How And When Drives Are Mapped

Bernie reassigns drive for IWM use on two occasions:

when you reboot Bernie, it scans the device chain and maps the 
first two drives with 800kB media to IWM unit I and unit II



when you mount a new disk image and IWM unit I or unit II are not 
mapped (for example because you previously ejected the disk 
in IWM unit I), the drive with the new disk image will become 
one of the undefined IWM units.

Note that Bernie tries hard to stay in synch with software that may 
be still accessing an IWM-mapped drive. For example, when you 
are using the arrow buttons to move a drive to a new position in the 
device chain, Bernie will also move the IWM mapping. An IWM 
mapping is only invalidated when you actually eject the media or 
reboot Bernie.

4.3 Technical Differences IWM / 
CleverPort

Software using IWM emulation transmits and receives data byte-by-
byte. (The CleverPort, on the other hand, communicates on block 
level which equals 512 bytes per transaction.) Consequently, IWM 
emulation is much slower than CleverPort. Luckily, we have highly 
optimized IWM emulation in Bernie so you won't notice a 
tremendous performance hit. Nevertheless, CleverPort is still faster 
and more flexible.

4.4 Copy Protection

Copy protection often manipulates disk bytes in a nonstandard way. 
This can go as far as formatting a disk as a spiral. It's therefore up 
to the software to read a protected disk and reconstruct the original 
data.

Although Bernie does feature low-level disk emulation, there's a big 
catch which basically neutralizes the inherent advantages of low-
level emulation. Think about how disks are read into memory: First, 
you insert a protected 3.5" disk into the built-in disk drive. Bernie 
then attempts to read from this disk. This read operation tells your 
Mac to transfer a few disk blocks from the media into memory and 
translating the encoded disk bytes (disk bytes are encoded in a 
rather complicated way) into regular blocks of 512 bytes each. If all 
goes well, Bernie translates the 512 byte blocks back into encoded 
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disk bytes and feeds them into the Apple II software, byte-by-byte. 
The point is that although the Apple II software will only see the 
encoded disk bytes, all data on a disk will first have to go through a 
decoding and encoding stage because the Mac can't be told to just 
retrieve the raw data as it comes in. The Mac always attempts to 
decode whatever it finds, and the Mac does not know about Apple II 
copy protection.

Put briefly, the fact that the Mac has the first shot on the protected 
disk prevents Bernie from running some copy-protected software 
because the Mac wants to decode disk bytes and expects to find 
data that is encoded in a standard way. If there's a copy protection 
that, the Mac will be unable to figure out what's on the disk and 
reports an error.

4.5 Zero Memory Footprint Caching

Zero Memory Footprint Caching is a dynamic caching algorithm that 
speeds up disk access with IWM emulation, especially when used 
in conjunction with slow peripherals. For instance, Bernie's caching 
tremendously speeds up transfer rates with physical 3.5" disks.

Zero Memory Footprint means that you need not allocate a disk 
cache or increase Bernie's application size in order to 
accommodate space for disk caches. Instead, Bernie configures 
and sizes its cache automatically and transparently without 
decreasing memory available for IIgs memory or other functions. 
Bernie maintains two separate write-through caches (one for each 
IWM drive) with average cache hits of between 20 and 30% 
(ballpark).

5. 5.25" Floppy Disks
Before 3.5" disks appeared in the mid 80ies, 5.25" floppy disks were 
the de facto standard in "mass media". Today, floppy disks are no 
longer used, but if you'd like to enjoy the hundreds of classic games 
and other, early milestones in Apple II computing, then they will 



most likely come on 5.25" disks.

5.25" support in Bernie is somewhat limited. It has been designed to 
enable you to run all those classic games like Choplifter, Hard Hat 
Mack, etc. Bernie's 5.25" implementation is not currently compatible 
with GS/OS. We are working on that.

Important: you can't format 5.25" disk images due to technical 
limitations.

5.1 5.25" Basics

Although hardware is radically different, Bernie ][ The Rescue 
integrates 5.25", 3.5" and SmartPort devices seamlessly in one 
device chain. You have become familiar with the "Disks" window in 
chapter 3, and 5.25" floppy disks are also displayed in the same 
window:

device chain with one 5.25" 
disk image

device chain with two 5.25" 
disk images

(for more information on the "P" icon, please turn to chapter "Disk 
Preferences".)

5.25" units do always appear at the top of the device chain

Bernie reserves two logical units right above the regular CleverPort 
units 1 through 8 for floppy disks. The two drives represents drive 1 
and drive 2 of an imaginary 5.25" disk controller in slot 6.

you can't move a CleverPort unit into the 5.25" area and vice 
versa

A CleverPort device can only be used with the CleverPort or, in 
case of 800kB disks, IWM emulation. Similarly, 5.25" floppy disks 
require a different "kind" of hardware emulation and thus can't be 
used with CleverPort or IWM emulation. The arrow buttons only 
work within the CleverPort/IWM area and within the 5.25" area.

you can move 5.25" disks from drive 1 to drive 2 and vice versa
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However, you can still use the arrow buttons in the "Disks" window 
to move a floppy disk in drive 1 to drive 2 on condition that drive 2 is 
empty. Analogously, a disk in drive 2 can be moved to drive 1 if the 
latter is empty.

ejecting a 5.25" disk

Analogously to CleverPort devices, you can eject a 5.25" disk by 
clicking on its drive door.

5.2 ProDOS or DOS 3.3 Formatted?

Bernie's two most widely used disk formats are DOS-order and 
ProDOS-order 5.25" disk images. This naming convention is highly 
confusing because it does not refer to the system software on a 
disk image but which formatting scheme has been applied for that 
disk. In order to understand the difference, here're a few comments 
on 'sector interleaving'.

A 5.25" disk consists of 16 sectors per track. 
DOS and ProDOS do not, however, write 
these sectors sequentially to disk but order 
them so that the read/write routines of the OS 
kernel achieve best possible throughput. In 
other words, each OS assumes an "interleaf 
factor" - a physical displacement of two 
logically adjacent sectors - so that the OS 
has some time for de- or encoding between 
two sectors.

For example, assume the head just flew over 
sector 1 and the OS read that sector into 
memory. Next, the OS needs to decode what 
it just read, and that process takes some 
time. When the decoding stage is completed, 
the OS continues reading the disk. Until that 
happens, about 5 sectors have gone by in the 
meantime. Hence the OS resumes reading 7 
sectors later, and the OS defines interleaving 
so that the next sector read is actually logical 
sector 2. If the sectors were ordered strictly 
logically, there would be quite some overhead 



- almost one full rotation per sector. With the 
introduction of interleaving, sectors can be 
read much more efficiently.

Now there're two bad things about this: first, 
the sectors are numbered only in the order as 
they appear physically on the disk (i.e. strictly 
from 0 through 15). Secondly, DOS and 
ProDOS have different interleaf factors which 
means that Bernie is unable to locate a 
sector without knowing which OS did format 
that disk.

The consequences of the differences in sector interleaving are that 
you have to decide which formatting scheme has been applied. The 
emulation world distinguishes between DOS-order images (for disks 
with DOS 3.3 interleaving) and ProDOS-order images (same for 
ProDOS). Disk images usually have a file name with a ".DO" or 
".PO" suffix.

When opening a 5.25" disk image, Bernie first tries to determine 
whether it's a ProDOS or a DOS-order image. It then asks you for 
the formatting scheme and makes its best guess the default choice:

Upon choosing a formatting scheme, Bernie sets the file type of the 
disk image so it can be recognized the next time automatically. 
DOS-order images will be given the file type DOS3 while ProDOS-
order disk images are of type PDOS.

Tip: if you are unsure about a disk's formatting scheme, choose 
DOS 3.3. DOS-order disks are much more common than their 
ProDOS counterparts.

Bernie also supports a third disk image: so-called "nibble" images. 
Images of that type usually have a ".nib" in their filenames. Images 
containing nibblized disk data do not require you to know which 
formatting scheme has been applied because they are a (more or 
less) 1:1 dump of the original disk. Bernie directly feeds "nibble" 
images into the emulated hardware, and it's up to the OS to make 
any sense of it.



5.3 Disk Images Recognized by Bernie

Bernie assumes that every file with a generic file type and a file size 
of exactly 140kB (143,360 bytes) or 227.5kB (232,960 bytes ) is a 
5.25" disk image. More precisely, the following file types may be 
used:

TEXT, ????, BINA, DSK5: files whose formatting scheme has to be 
determined manually

DOS3: disk images that have been formatted with DOS 3.3
PDOS: disk images that have been formatted with ProDOS
NIBL: 1:1 disk copy containing disk data in its nibblized form
The DSK5 files originate from "Stop The Madness", an Apple II+ 
emulator for Macintosh computers. You can use these images 
directly.

Most disk images ship in either DOS-order or ProDOS-order format. 
This format is the preferred choice for unprotected software. 
However, protected software will possibly not work with these 
formats because they do assume a standardized disk layout.

For protected software, your only choice are nibblized disk 
images that directly dump the data as it appears "under the drive 
head" to the disk image file. These images are a bit larger in size 
because they also record all the bytes needed for synchronizing 
and positioning the drive head. Nibble images are not a creation of 
Bernie but are used by other emulators and support has been 
added for compatibility with existing images. Although the name 
suggests otherwise, the nibble format does not perfectly mimic a 
5.25" floppy disk. (Techies: there is no halftracks support and tracks 
have fixed length.) Consequently, a disk image format that does not 
capture 100% of a disk may fail in some situations. If you are only 
downloading disk images, this is a non-issue because people who 
have uploaded nibble images have done so because it works for 
that particular software. You should keep this in your mind only 
when you're going to make your own copies.

5.4 Additional Technical Information

Bernie's current 5.25" hardware emulation features two tweaks, an 
auto-alining mechanism and a 'turbo' mode for improved 
throughput. Both features are disabled for nibble disk images.



The auto-aligning mechanism improves head positioning accuracy 
during write operations. It can't be turned off.

The 'turbo' mode is currently always enabled (except for "nibble" 
images) and can't be disabled. It improves overall throughput during 
read operations by as much as 30% average (ballpark) but also 
introduces odd disk behavior from the viewpoint of the emulated 
software. We have tested the corresponding code intensively and 
couldn't find any incompatibilities caused by this tweak. An 
upcoming release will allow you to turn it off.

5.25" emulation does not use caching.

6. CataDog™ File Browsing
CataDog™ is a stand-alone file cataloging utility integrated into 
Bernie. It allows you to:

view the complete catalog of a disk, disk image or shared volume
view file types and file sizes
filter catalogs by file type
CataDog is compatible with any ProDOS-formatted disk. It also 
supports extended GS/OS files. CataDog does not support HFS, 
DOS 3.3 or MFS formats.

6.1 Cataloging a Disk

CataDog works closely with Bernie's "Disks" window. You select the 
disk you wish to catalog in the "Disks" window. (To open the "Disks" 
window, push command-shift-D or open the Window menu and 
choose "Disks".)

Next, select a single disk by clicking on its drive icon once:

select a disk (image) by clicking it once



Afterwards, open the Window menu and choose "Catalog". This 
brings up a new window that may look similar to the one below:

The CataDog window displays the following information:

file name or folder name
file type as a hexadecimal code or three-letter abbreviation if 

available
file size
total number of files and folders displayed
The window works very much like Mac Finder windows. Directories 
have a small arrow to the left. Clicking this arrow expands and 
collapses a directory.

Tip: If you wish to expand an entire file tree (that is, see all files and 
directories inside a folder), option-click a folder.

Tip: If you wish to resize the window horizontically so you can just 
see all information, click the window's zoom box.

6.2 Browsing By File Type

CataDog also includes a filter so you only see files of a particular 
file type. Bernie understands all official three-letter abbreviations 
(such as AWP, TXT, BIN) and hexadecimal codes.

To activate the type filter, click the "ALL" button in the CataDog 
status bar. The button is highlighted and shows an ellipsis.

You have now the possibility to:

enter a three-character abbreviation or
a hex code.
Let's filter all binary files of type BIN:

Type B, then I, and finally N:



When you enter the last character, Bernie will check the completed 
code. If it can't find it in its internal database, it will bark and go back 
to the ellipsis.

If the code could be recognized successfully, the catalog will 
immediately reflect the new filter setting.

Analogously, if you'd like to specify a file type by its hexadecimal 
code, you enter a dollar sign plus two hexadecimal digits such as:

To disable the type filter and view all files and folders, click the file 
type field again.

Communications

1. Introduction

2. Credits

3. Configuration

3.1 Choosing a Port: Port Menu Items
3.1.1. Port Setting "Off"
3.1.2. Port Setting "File"

3.1.3. Port Setting "Printer Port" and "Modem Port"

3.1.4. Port Setting "Internal Printer/Modem Port"

3.1.5. Port Settings Only Show "Off" and "File"!
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3.2. Port Speed

3.2.1. Automatic Port Speed
3.2.2. Setting Port Speed Manually

4. Baud Rate And Protocol Options

4.1 Special Baud Rate Considerations

5. Handshaking

5.1. Software Handshaking
5.2. Hardware Handshaking

5.2.1. Ignore DTR
5.2.2. Hardware

5.2.3. Software (XON/XOFF)

5.2.4. Emulated DTR

5.3. Compatibility Mode

6. The Communications Window

6.1. Port Active
6.2. Rx In Progress

6.3. Tx In Progress

6.4. Communication Error

6.5. DTR Handshake, Tx Handshake

6.6. Rx/Tx Buffer Fill Grade

6.7. LCD Multipurpose Display 
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7. Performance Tips

1. Introduction
Communications support is one of the most challenging 
tasks for emulation software. With Bernie, communications 
support has been implemented using a very hardware-
oriented approach offering compatibility with virtually all 
software accessing the Apple IIgs' serial port architecture. 
Please note that Bernie does not support AppleTalk at this 
time.

Bernie's serial communications support is referred to as 
CerealPuffs™ (aka serial ports), and the port administration 
code - that also manages Mac serial ports for InkDirect™ - 
is called MuesliPump™. This section describes Bernie's 
CerealPuffs technology, how to configure the ports, 
emulation limitations, and performance tips.

Speed is everything with telecommunications. It means 
bandwidth and getting things done sooner. For emulation 
software, communication speed also stands for added 
overhead because the same signals, flags, and 
maintenance tasks have to be processed at extremely high 
frequencies. As an example, a connection at 28,800 baud 
not only implies a throughput of (max.) 3.5kB per second but 
also an insane emulation-specific overhead of 28800 
interrupts per second, or just a mere 34 microseconds for 
completely dealing with an emulated interrupt cycle (plus 
doing regular stuff). This example shows why choosing a 
high connection speed does not always lead to the expected 
outcome. In fact, it can place such a burden on the system 
that your there's no time left for doing anything reasonable!
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Getting Help

If you have questions regarding communications, feel free to 
go to contact the communications guy.

2. Credits
It is very unusual to put the credits at such a prominent 
place, but F.E.Systems owes a few people that kind of 
appreciation.

We would like to thank Richard Bennett for helping during 
the entire development cycle at a level that goes far beyond 
the usual Q & A support. Richard has written Marinetti, the 
popular TCP/IP software for Apple IIgs computers, and 
implemented the serial drivers for Seven Hills Software's 
commercial Spectrum communications software. Put briefly, 
he's the guy who knows answers to serial questions. And, 
honestly, without Richard offering his help, we're not sure if 
we had tackled serial communications at all.

We would like to thank Ewen Wannop - another Spectrum 
programmer - who is getting increasingly involved with 
Bernie's serial communications, and are looking forward to 
improving Bernie to meet Spectrum's needs.

Writing software with that kind of support is just more fun.

3. Configuration
Configuring serial ports is a snap:

mailto:emutech@magnet.ch


Bernie is emulating both the Apple IIgs printer and modem 
ports. Each of the two ports can be connected with any 
serial port or device on your Mac (serial ports, most internal 
modems, some PC cards, third-party serial cards, etc.). 
Bernie is offering three different ports:

Apple IIgs printer port
Apple IIgs modem port
InkDirect™
(InkDirect™ is a low-level printing technology and discussed 
in a separate chapter.) Each of these emulated Apple IIgs 
ports can be associated with a Mac serial port.

3.1 Choosing a Port: Port Menu Items

A port can be either off or linked to a Mac port. There's a 1:1 
relationship between Apple IIgs ports and Mac ports, that is, 
a Mac port can only be linked to a single Apple IIgs port and 
vice versa.

When you have chosen a Mac port for, say, the Apple IIgs 
printer port, that Mac port is dimmed in all other port 
selection menus. You can't select that Mac port for any other 
emulated port. If you would like to reassign the Mac port to 
another port, you need to reset the original connection first 
(by setting the port to off) and then make your new choice.

Redirecting output to a File - as the port selection menus 
suggest - is not yet implemented and always dimmed. Let's 
have a more detailed look at each of the settings:

3.1.1. Port Setting "Off"

When a port is set to "Off", Bernie will only service the port 
so the software sees a fully functional serial controller that is 
not connected with the outer world. This setting is, for 



example, sufficient for running Diversi-Tune that is using the 
serial controller for timing purposes but does not actually 
transmit or fetch any data (as long as MIDI is disabled.)

3.1.2. Port Setting "File"

This feature is not yet implemented and always dimmed.

3.1.3. Port Settings "Printer Port" and "Modem Port"

These two are most commonly seen port types and 
correspond to the two serial ports that are ingredients of 
most if not all desktop Macs.

3.1.4. Port Setting "Internal Printer/Modem Port"

This port is usually what you get with a PowerBook or a Duo 
without docking station/minidock.

3.1.5. Port Settings Only Show "Off" and "File"!

Communication support is only available in registered 
versions of Bernie. If your copy is not registered, then the 
port menus will only show the "Off" setting and the dimmed 
"File" option. You can get the rest of the menu at a very fair 
price.

3.2 Port Speed

With Bernie, you can tell Bernie to choose a port speed for 
you automatically or select a specific baud rate. The baud 
rates for each port are independent of each other.



3.2.1 Automatic Baud Rate

Since Bernie is emulating the Zilog communications 
controller, it knows very well what port speed your Apple IIgs 
is requesting. Thus you can tell Bernie with the Auto setting 
to set the Macintosh port to whatever baud rate the Apple II 
software is asking for. For example, if your telecom software 
configures your Apple IIgs modem port to run at 9,600 baud, 
Bernie would tell your Mac to establish a 9'600 connection 
on the Mac side.

Unfortunately, there are some rather unusual port speeds 
not support by the Macintosh. In that case Bernie is picking 
the next higher port speed.

3.2.2. Setting a Port Speed Manually

If you have a fast Macintosh and you want to take 
advantage of your systems performance, the port speed 
menu lets you select a specific port speed. The speed you 
select will be the rate at which Bernie will actually 
communicate with the outer world. The advantage of 
overriding port speed is that you can feed your Apple II 
software much faster than it was originally designed for. And 
because Bernie is typically running much faster than a stock 
Apple IIgs, it is very likely your software can deal with it.

Please note that you often can't increase port speed to an 
arbitrary value. For instance, if you have a serial device that 
can't go faster than 9600 baud, you won't be able to 
communicate at higher baud rates than this.



4. Baud Rate And Protocol 
Options
Except for the linking of Apple IIgs Ports to Mac ports, the 
whole configuration of the serial ports is done through your 
Apple II communications software. Please refer to the 
documentation of your telecomm software of how to adjust 
the baud rate and protocol options (parity, data and stop 
bits).

Bernie supports:

any port speed up to 57,600 baud
5, 6, 7 and 8 data bits
odd, even parity, or none
Bernie does not support AppleTalk at this time. 

For example, the configuration screen in ProTerm looks like 
this:

(Missing Picture) 

These settings will configure the ports for 4800 baud, 8 data 
bits, no parity, 1 stop bit.

5. Handshaking
Understanding handshaking requires a thorough 
understanding of how communication devices interact. Feel 
free to skip this discussion if you're new to Bernie or just 
don't want to bother with technical details. Please come 
back when you'd like to use a modem or network.



Whenever two persons or machines are communicating, 
people and machines must agree upon certain gestures or 
signals to indicate that communication can start.

Handshaking controls the flow of data between two devices. 
When one device is tinkering with the handshaking signal, 
the other knows that there is some problem on the other end 
and communication should be suspended until further 
notice. This may happen because the device must pay 
attention to something else, it encountered an error or the 
unexpected happened.

In the communications world, there are two commonly used 
methods of implementing handshaking: software 
handshaking and hardware handshaking.

5.1. Software Handshaking

Software handshaking is based on a convention between 
the sender and receiver. They agree on special characters 
that signal "I'm ready" or "stop sending me data". This 
method is simple and works pretty well, but it has the big 
disadvantage that there are special characters that may not 
be used within regular data packets because they would be 
interpreted as handshaking signals. Therefore, software 
handshaking may not be used for transmitting binary 
data (8 bits) but with ASCII text only. Text messages have 
the property of making use of only a very limited range of 
characters so that certain symbols are used for controlling 
data flow.

Software handshaking is also called "XON/XOFF 
handshaking".



5.2. Hardware Handshaking

If you need to transmit data with full 8 bits, there's a special 
line commonly referred to as "Data Terminal Ready", or 
DTR. DTR indicates whether a device is ready for 
communication or not. It basically does the same thing as 
software handshaking but is making use of a hardware 
signal.

The problem with DTR is that it is not really popular on the 
Mac to use DTR for handshaking. Modems for example are 
using the DTR line for something else: to hangup. (You 
really wouldn't want to hangup and redial every time your 
Apple II software is requesting a short time-out!) Therefore, 
Bernie features a number of methods for emulating DTR - 
this enables your Apple IIgs software to rely on DTR while 
offering compatibility with Macintosh serial devices.

The Communications panel in the Preferences window 
includes a popup menu for choosing a DTR emulation. This 
menu is valid for both Apple IIgs ports. Each option will be 
discussed in detail hereafter.

5.2.1. Ignoring DTR

The "Ignore" setting is a brute force approach - handshaking 
will simply be ignored. This means that your Apple IIgs has 
no means to indicate to the sender that it should stop 
sending data.

5.2.2. Hardware

The preferred option is full hardware emulation of the DTR 
signal. This means that a device will see a change in DTR 
when your Apple II software is accessing DTR.



While this option could be described as the only faithful DTR 
emulation, it assumes that the serial device knows what a 
change in DTR means. Unfortunately, most of today's 
modems are using DTR for a different purpose, namely for 
holding a connection alive. Asserting the DTR line does not 
affect handshaking but disconnects your connection 
completely which is not exactly what you wanted. Please 
consult your modem's manual to see if it supports DTR for 
handshaking.

Hardware emulation is the preferred choice if your serial 
device supports DTR handshaking.

5.2.3. Software

If you are only transmitting/receiving text data, Bernie allows 
you to map hardware handshaking to software handshaking. 
Changes in the DTR signal will be mapped to their software 
handshaking equivalent, that is Bernie is sending 
XON/XOFF characters depending on the state of the DTR 
signal.

Software emulation is the preferred choice when sending 
ASCII text.

5.2.4. Emulated

The last choice is "emulated DTR", a pretty sophisticated 
Bernie special. Instead of actually routing DTR information 
to the serial device, the DTR signal is processed entirely 
within Bernie.

A request to stop sending data is typically caused because 
the software needs some time to recover from a task or 
save the previous data to disk. Bernie starts buffering the 
incoming data until your Apple II software is back and ready 
to fetch more data.



The drawback of this method is that Bernie's buffer is rather 
small and tends to overflow itself soon. So this 
implementation does not work when your software needs a 
long time to recover. Bernie does use software handshaking 
when it can't buffer data any longer, but then the same 
limitations as described in "Software" above apply.

Emulated DTR is the preferred choice when your Apple II 
software can keep up with data flow and only rarely needs 
time to recover.

5.3. Compatibility Mode

Serial communication is truly a bottleneck, that's why Bernie 
is optimizing a few steps to make it go real fast. 
Unfortunately, one or two applications make very strong 
assumption on how much data comes in and when there's 
time left to process it. Too many assumptions for our taste.

Bernie's compatibility mode is slowing down bandwidth but 
addresses these problems. Applications affected are 
ProTerm and ReadyLink.

If you are looking for a solid telecommunications software 
that has been fully tested with Bernie ][ The Rescue, we 
recommend you to check out Spectrum (commercial) and 
Marinetti (currently freeware). These two products are 
mature products and still being worked on.



6. The Communications 
Window
The communications window gives you an overview of your 
serial connections. The window consist of two panels, one 
for each emulated port:

(Missing Picture)

Rx = "Receiver" (incoming characters), Tx = "Transmitter (outgoing 
characters)

6.1. Port Active

Next to the Port A/B is a LED that goes on when the port is 
"connected", that is, when you have linked it to a Mac port. 
You can activated a port in the Communications panel of the 
Preferences window.

6.2. Rx In Progress

The "RD" light turns green whenever a read operation is in 
progress. Bernie is then fetching characters from the Mac's 
serial port and passes them to the Apple II software.

6.3. Tx In Progress

The "TR" light turns green whenever a send operation is in 
progress. Bernie is then transmitting characters the Apple II 
software feeded into the serial controller and passes it onto 
the serial port.
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6.4. Communication Error

With every connection, communication errors may appear 
and have to be dealt with. The communication error 
happens between the serial device and Bernie (and not 
between the Apple II software and Bernie). Bernie is 
detecting errors and passes this information on to the Apple 
II software. When an error occurred, the "ERR" light goes on 
and an error message appears in the LCD display below.

6.5. DTR Handshake, Tx Handshake

These two indicators show whether data is "flowing" or 
transmission has been suspended. If the DTR Handshake is 
on, incoming characters will be buffered but not delivered to 
the Apple II software. Plus, the sender will be notified of the 
change in DTR. (Note that the exact behavior of DTR 
depends on how you have configured DTR emulation.)

Analogously, Tx Handshake reflects the state of outgoing 
characters. If the Tx Handshake LED is on, no characters 
will be transmitted.

6.6. Rx/Tx Buffer Fill Grade

The LEDs show how many bytes are waiting to be delivered 
to the Apple II software (Rx) or the serial device (Tx).

6.7. LCD Multipurpose Display

Lastly, each port is featuring a small display. This display 
keeps you informed on:

the current port speed
flow control (DTR, CTS, XON, XOFF signal changes)
error conditions (framing errors, parity, overflow, break 

conditions)
"OFF" if the port is inactive
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7. Performance Tips
As you remember from the introduction, speed is very 
critical and communications support requires a lot attention 
from the CPU. We have stated that the faster a port is 
running, the more overhead is produced which in turn may 
degrade performance and reliability (since there's no 
hardware handshaking yet.)

Several real-world experiments and feedback from users 
showed that a good communication speed is around 9600 
baud. On first-generation Macs (60-80 Mhz), real-world 
throughput is around 6000 or 7000 baud, so it is pointless to 
choose higher connection speeds. Instead, talking at 7200 
or 9600 baud is a real gain because emulation overhead will 
give your Mac more room to breathe and actually allows for 
a steady communication at Bernie's maximum bandwidth.

If you own faster Macs, you can extrapolate reasonable 
settings for your machine. For 150 Mhz Macintosh 
computers, you might well experience best performance at 
32,800 baud - it is left as an exercise to the user to find the 
best setting. There are simply too many external factors 
(overall system speed, background tasks, third-party tools 
slowing down) that we can give you an ultimate 
recommendation.



Printing

1. Introduction

2. InkMeister Light™

2.1 AppleSoft BASIC
2.2 ORCA Shell (GS)

2.3 AppleWorks Classic

2.4 Form Feed on a Partially Printed Page

2.5 Preferences

2.5.1 Force Monospaced
2.5.2 Font and Size

2.5.3 Margins

2.5.4 Line Length

2.5.5 Printer Command Style

2.5.6 Form Feed Timeout

2.6 Printer Codes

3. InkDirect™

4. InkMeister Pro™
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5. The InkMeister™ Control Center

5.1. Scale Popup
5.2. Double/Halve Scale

5.3. Preferences Button

5.4. Page Setup Button

5.5. Print Button

5.6. Page Flip Buttons

5.7. Form Feed Button

5.8. Clear Queue Button (Trash Can)

5.9. Printing without Preview

1. Introduction
 Since the first incarnation of InkMeister™, other possibilities 
to print your documents have been continually added. So 
there are now four technologies:

InkMeister Light™ translates single characters passed 
through the GS slot 1 by 8-bit Apple II- and text based 
GS/OS software into QuickDraw, the Mac's native 
imaging system. This enables you to see this sort of 
output in a preview window (the so-called "InkMeister™ 
Control Center"), and to print it on any MacOS 
compatible printer.

InkDirect™, introduced with Bernie v1.3 allows you to send 
the characters passing through the GS slot 1 directly to 
a Mac serial port of your choice. This way the 8-bit 
Apple II- or text based GS/OS software is able to 
control a printer attached to that Mac serial port.
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InkMeister Pro™, which is not yet finished, allows you to 
print graphics and text from GS/OS desktop 
applications. To use this option you install the GS/OS 
printer driver called "InkMeister" supplied with Bernie in 
your GS/OS system. This driver passes GS QuickDraw 
II commands to Bernie, where they are translated into 
Mac QuickDraw commands for previewing and printing. 
As of now some features are not yet implemented, 
among them bitmaps and direct printing (i.e. preview 
mode is required).

Cereal Puffs™, introduced with Bernie v1.3, support the GS 
Serial Ports by connecting them to the Mac serial 
port(s) of your choice. With this configuration you can 
print like on a real GS, using the usual printer drivers 
and cables. Since this solution emulates the chip used 
for serial communication in a real GS, it uses a bit more 
CPU power from your PowerMac than the other three 
technologies. This technology is described in detail in 
the Communications chapter of this documentation.

Getting Help

If you have questions regarding InkMeister™ Light, Pro or 
InkDirect™, feel free to contact Urs Hochstrasser of 
F.E.Systems.

2. InkMeister Light™
InkMeister Light™ is the integrated text printing solution for 
Bernie ][ the Rescue. For once we departed from the 
principle of emulating 'metal'. The reasons for this are 
simple: MacOS compatible printers are page printers 
(QuickDraw or PostScript devices) rather than text printers. 
However, most 8-bit Apple // titles, among them the very 
popular AppleWorks Classic, expect just such a text printer.
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That is where InkMeister Light™ comes in. It allows 8-bit or 
text based GS/OS software (such as the ORCA shell) to 
print to a virtual text printer. The output is then converted to 
a format your MacOS compatible printer can understand 
and print accordingly.

InkMeister Light™ emulates a text printer attached to slot 1, 
but it doesn't support all the details you can set for the 
actual Printer Port.

InkMeister Light™ requires Slot 1 to be set to "Your 
Card" in the Apple IIgs Control Panel. If slot 1 is set to 
"Printer", do this:

enter the Control Panel
open the "Slots" sub-panel
change slot 1 to "Your Card"
close the "Slots" screen by hitting the RETURN key, and 

leave the Control Panel
reboot the emulated Apple IIgs (changes will not take 

effect until you reboot)
You can reboot the emulated Apple IIgs by choosing "Reset" 
from the "Setup" menu.

When you print the first time the 'Preview' option will be 
enabled (you can check this in the 'InkMeister' submenu in 
the 'File' menu). Therefore the 'InkMeister Control Center' (a 
preview window) will appear when the first page is finished. 
You can invoke this window with the 'Printer' command in 
the 'Window' menu as well. More on the preview window 
later.

International Characters

InkMeister Light™ supports all foreign character sets you 
can select in the GS' Control Panel ('Display language'). 
InkMeister Light™ reads this setting and translates its 
output accordingly. Due to this mechanism you can't mix 
foreign characters from different sets on the same printout.



Line Length

Some software doesn't limit the length of printed text lines 
(e.g. Applesoft BASIC). Therefore you can set the line 
length in the Preferences.

2.1 AppleSoft BASIC

In BASIC you can use

PR#1
to redirect output to InkMeister Light™. Accordingly, in the 
monitor you would use 1<CTRL-P>. Of course the same 
rules apply as if you were using a real printer, so when using 
DOS 3.3 or ProDOS BASIC.SYSTEM you should use

PRINT CHR$4;"PR#1"
in BASIC programs instead. To print listings or other output 
with lengthy lines you can limit the line length in the 
Preferences

2.2 ORCA Shell (GS)

You need to install the .PRINTER driver which came with 
your ORCA package prior to using InkMeister Light™. After 
installing you can redirect output to the printer as usual:

catalog > .printer
It might be necessary to disable the 'add LF after CR' 
feature in the ORCA text printer control panel to avoid 
double spaced text.

2.3 AppleWorks Classic

In order to print from AppleWorks you need to create a 
Custom Printer Driver. Here's how to do it in AppleWorks 
Classic 3.0:
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To do this you select 'Other Activities' from the main menu in 
AppleWorks. There you select 'Select standard settings for 
AppleWorks', and then 'Specify information about your 
printer(s)'.

Select 'Add a printer' (remove another if necessary), select 
'Custom printer' and call it 'InkMeister'.

Give 'Slot 1' as access.
Set the following options:
'Needs line feed after each return': NO
'Accepts top of page commands': YES
'Stop at end of each page': as you like (recommended NO)
'Platen Width': 8.0 inches (unless you print in landscape 

orientation)
'Printer codes': see step 5
'Interface cards': select and set 'Current control chars' to 

'None' (normally there is 'Control-I 80 N'. Remove 
it).

Set Printer Codes You can set codes for 'Boldface, 
Subscript and Superscript' and for 'Underlining'. The 
codes are given in the Printer Codes section below. For 
underlining use 'Printer has start/stop underline 
commands'. There are more options (Italics, Outline 
and Shadow) which you can set with 'Special Codes'.

Return to the main menu by pressing the 'Escape' key 
several times. You are now set to use InkMeister 
Light™ with AppleWorks Classic.

HINT: AppleWorks asks you 'How many 
copies?' before printing. Leave this at 
'1' since you can set the number of 
copies in your MacOS Print Dialog. 
This will be much faster!
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2.4 Form Feed on a Partially Printed Page

A page is only printed (or appears in the preview window) 
when it is finished, i.e. when the page is full or InkMeister 
Light™ received a form feed character (Control-L) from the 
software. If you want to get your page immediately you can 
invoke the 'Form Feed' command from the 'InkMeister' 
submenu ('File' menu) or by clicking on the Form Feed 
Button in the preview window. If Form Feed Timeout is 
enabled, a form feed is forced after 30 seconds of printing 
inactivity. This won't be necessary in AppleWorks Classic 
since it sends a Form Feed automatically.

2.5 Preferences

You invoke the InkMeister™ specific preferences panel by 
selecting 'Preferences...' from the 'Setup' menu (and clicking 
on the printer icon) or by clicking on the 'Preferences' Button 
in the preview window.

2.5.1 Force Monospaced

Although the recommended default font for InkMeister 
Light™, Courier, is a monospaced font, this is not the whole 
story. When printed in boldface or another more space 
consuming typeface even a character from the Courier font 
takes up more space. This is a general problem on the Mac 
if you want to align monospaced characters.

Therefore InkMeister Light™ offers a solution with this 
'Monospaced' mode. If it is enabled, every single character 
is placed individually and exactly. This yields proper 
alignment in text screen based word processors like 
AppleWorks Classic. On the other side this method is very 
time consuming and printing is slowed down considerably.

HINT: If available, you can also choose the font 



Courier New instead of enabling "Force 
Monospaced". CourierNew is 
monospaced across all font variations, 
and it allows you to perfectly align text 
without having to enable InkMeister™ 
Light's time & memory-consuming "Force 
Monospace" option.

2.5.2 Font and Size

Here you can choose any font installed in your system and a 
fair amount of different point sizes. There are some 
important issues about the selection of these parameters.

If you want your text to align properly stick to Courier or 
another monospaced font

Don't use 'Force Monospaced' on a proportional font (such 
as Helvetica or Times); it just looks awful!

In the present version of InkMeister Light™ line height is 
fixed to 12 points. Use bigger font sizes at your own 
risk.

2.5.3 Margins

You can set InkMeister™ Light's margins manually (in 1/4 
inch increments) or automatically to the printable area of the 
page. If you need exact alignment in relation to the paper, 
specify zero margins ('None').

2.5.4 Line Length

Some software doesn't limit the length of printed text lines 
(e.g. Applesoft BASIC). Therefore you can set the line 
length (Unlimited, 30, 72, 80 or 132 characters). When 
printing from AppleWorks Classic, set this option to 
'Unlimited'.



2.5.5 Printer Command Style

As explained in 'Printer Codes' below you can specify printer 
commands with Esc or additionally with <...> brackets. 
Since the latter method prevents you to print a '<', it is an 
option.

2.5.6 Form Feed Timeout

This feature frees you from the burden of giving manual 
form feeds. After 30 seconds of printing inactivity it forces a 
form feed.

2.6. Printer Codes

Printer codes can be given in two different styles. The first 
method uses the 'Escape' Character (ASCII 27) to tell 
InkMeister Light™: here's a command! This method is 
useful in most cases, especially in word processors like 
AppleWorks Classic, where you can define 'Escape' codes 
in a printer driver.

However, if you want to format your text just using a text 
editor (as the ORCA editor for example) you can't put 
'Escape' into the text. Therefore there is a second method 
using '< >' brackets to tag a command. This mode is 
normally disabled since it prevents you from printing these 
brackets altogether! You can set the option in the 
Preferences panel (invoked with 'Preferences' from the 
'Setup' menu and clicking on the printer icon, or directly in 
the preview window button bar).
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Examples for both command styles: Esc BB equals <BB> 
(Boldface Begin).

Begin End

Boldface BB BE

Underline UB UE

Subscript -B -E

Superscript +B +E

Italics IB IE

Outline OB OE

Shadow SB SE

3. InkDirect™
Introduced with Bernie v1.3, this technology allows you to 
send the characters passing through the GS slot 1 directly 
to a Mac serial port of your choice. This way the 8-bit Apple 
II- or text based GS/OS software is able to control a printer 
attached to that Mac serial port directly.

Since InkDirect™ gets its data by the same mechanism as 
InkMeister Light™, it requires Slot 1 to be set to "Your 
Card" in the Apple IIgs Control Panel. If slot 1 is set to 
"Printer", do this:

enter the Control Panel
open the "Slots" sub-panel
change slot 1 to "Your Card"
close the "Slots" screen by hitting the RETURN key, and 

leave the Control Panel
reboot the emulated Apple IIgs (changes will not take 



effect until you reboot)
You can reboot the emulated Apple IIgs by choosing "Reset" 
from the "Setup" menu.

To enable InkDirect™, you open the 'Preferences' dialog 
from the 'Setup' menu. Then you select the 'Serial' 
preference panel:

In the 'InkDirect' part of this panel you can enable InkDirect 
by selecting a Mac serial port in the 'Port' popup menu.

A port can be dimmed when

The port was in use by some other program or the system 
software when Bernie was launched. In this case it will 
stay dimmed until you quit Bernie. If the port had been 
left open by some haywire program you need to reboot 
your Mac to get the port back.

The port is in use by one of the GS ports (by the 
CerealPuffs™). When you disable that port, the 
corresponding Mac port will be available again.

If no ports are displayed in the popup menu, there might be 
something wrong with your registration...

The 'File' menu item is dimmed on purpose: this feature is 
not yet implemented.

The remaining popup menus are used to configure the 
selected serial port. They are modeled after the 'Apple 
Serial Tool' from the 'Communications Toolbox' and 
implement the typical Macintosh serial architecture. This 
seems to be a bit different from the GS. If you need an exact 
copy of the GS serial ports, use CerealPuffs™ instead.
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The check boxes have the following meaning:

Add LF after CR Some printers require a 
LF (line feed character) 
after a CR (carriage 
return). If the software 
you are using doesn't 
support this, you can 
enable it here.

Strip MSB Some Apple II text based 
software sets the MSB 
(most significant bit) of 
each character to 1 for 
normal text, even when 
printing (e.g. Applesoft 
BASIC). Most printers 
don't like this, because 
the standard ASCII code 
doesn't use the MSB at 
all. By enabling this 
option you can reset that 
bit to zero to make your 
printer happy.

The instructions in the InkMeister Light™ chapter 
concerning Applesoft BASIC, ORCA Shell (GS) and 
AppleWorks Classic apply with the following exceptions:

The 'Line length' popup in the 'InkMeister' preferences panel 
doesn't apply to InkDirect™.

In AppleWorks Classic you must select the appropriate 
printer driver for your printer. Interface init strings must 
be disabled (the infamous Control-I 80 N).

If your printer needs an LF after CR, enable it only once 
(either in the printer driver or in the InkDirect™ 
preferences).

The rest of the InkMeister Light™ chapter doesn't apply to 
InkDirect™, neither does the 'InkMeister' preferences panel.
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NOTE: As soon as InkDirect™ is enabled, 
InkMeister Light™ won't be able to 
print, until you disable InkDirect™ 
again. InkMeister Pro™ is not 
affected.

4. InkMeister Pro™
InkMeister Pro™ allows you to print graphics and text from 
GS/OS desktop applications. To use this option you install 
the GS/OS printer driver called InkMeister, supplied with 
Bernie in your GS/OS system. This driver passes GS 
QuickDraw II commands to Bernie, where they are 
translated into Mac QuickDraw commands for previewing 
and printing. Some features are not yet implemented. This 
release handles: basic graphic objects (circles, rectangles, 
lines, points), fill and frame patterns and colors for these 
objects in 640 mode, blend dithered colors or print pure 
colors, text.

It does not support yet: long text, pixmaps, regionsdirect 
printing (i.e. preview mode is required).

InkMeister Pro™ is software shipping in two parts. One part 
is integrated into Bernie, the other half is a custom printer 
driver that comes on a tiny disk image (InkMeister Pro 
Driver). To install InkMeister Pro™, follow these steps:

Launch Bernie
mount the "InkMeister Pro Driver" image



copy the InkMeister Pro driver to the folder 
*:System:Drivers: on your GS/OS startup disk

now open the control panels from the Apple menu (in the 
emulated IIgs, not on your Mac)

open the "DC Printer" panel
select "InkMeister" in the "Printer Type" list. (You can ignore 

the upper list.)
Congratulations, now you can print from within GS/OS 
desktop applications!!

Please keep in mind:

always enter a valid page range when printing. Most 
applications do deal properly with partially specified 
printer records, but for example AppleWorks GS makes 
quite a mess if you leave these fields blank.

almost all controls in the InkMeister Pro 'Page Setup' and 
'Print' dialogs are not wired yet. They simply do nothing. 
Exceptions: the Color Blend check box and the Page 
Range do work.

In this version you can only print to the preview window (and 
from this onto paper), thus direct printing without 
preview is not yet implemented.

5. The InkMeister™ Control 
Center
This window is also called the preview window. Any time 
something is printed to InkMeister Light™ or InkMeister 
Pro™, and preview mode is enabled (in the 'InkMeister' 
submenu in the 'File' menu), this window pops up and 
displays the output. You can also invoke this window by 
selecting 'Printer' in the 'Windows' menu.

In this window you always see a gray outline, even if there is 
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nothing printed yet. The gray area indicates the non-
printable area of your printer to help you adjust the margins 
if necessary (see section Preferences for details).

NOTE: If you don't see a gray outline, 
please check whether you have 
selected a printer in the Chooser 
or as desktop printer. If you 
select a printer, you need to do a 
Page Setup prior to printing.

There are several controls at the bottom of the window 
which are described here in more detail:

5.1. Scale Popup

You can look at your output in several magnifications, from 
400% to 25%. Moreover there are two special display 
modes: 'Fit' fits the whole page, whatever the size and 
shape of the window. 'Shady' fits the page to the width of the 
window. Users with large screens might like that feature...

5.2. Double/Halve Scale

These buttons double or halve the view scale of your output. 
Disabled when in 'Fit' or 'Shady' mode.

5.3. Preferences Button

Go directly to the InkMeister™-related panel of the 
'Preferences' dialog. This might take a while if you invoke it 
for the first time and have a lot of fonts installed on your 
Mac.
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5.4. Page Setup Button

Invokes the Mac's Page Setup dialog. Same as selecting 
'Page Setup...' from the 'File' menu.

5.5. Print Button

Invokes the Mac's 'Print...' dialog and prints the contents of 
the print queue (the pages in the preview window). It clears 
the queue afterwards.

5.6. Page Flip Buttons

If there are more than one page in the preview buffer you 
can flip pages (browse the queue) with these buttons. The 
current page number is displayed between the two buttons.

5.7. Form Feed Button

Forces a form feed on an unfinished page. Same as 'Form 
Feed' from the 'InkMeister' submenu in the 'File' menu.

5.8. Clear Queue Button (Trash Can)

Clear the print queue and get rid of the preview window's 
content. Same as 'Clear Queue' from the 'InkMeister' 
submenu in the 'File' menu.



5.9. Printing without Preview

If preview mode is disabled, InkMeister™ prints directly, 
without putting up a 'Print' dialog. Instead it takes the 
settings from the last print job or creates a new one with 
default values.

NOTE: Printing without preview is not yet 
implemented for InkMeister 
Pro™.

Preferences

1. Introduction

1.1 Window Behavior

2. Presets

2.1 What's a Preset?
2.2 Creating a Preset

2.2.1 Creating a Preset File
2.2.2 How Presets Are Stored

2.2.3 Choosing a Preset

2.2.4 Adding Preferences to a Preset

2.2.5 Dropping a Control Gives You an Error Message
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2.2.6 Adding All Preferences (Copy Globals)

2.2.7 Adding Special Features

2.2.8 Replacing Items

2.2.9 Deleting Items

2.3 Applying Presets

2.4 Deleting Presets

3. Disk Preferences

3.1 Attaching Preferences to Disk Images
3.2 Applying Disk Preferences Automatically

3.3 Deleting Disk Preferences

3.4 Shared Volumes and 3.5" Floppies

1. Introduction
Bernie features a wide range of customizations. A few 
selected options that you might need to change often are 
available directly from the Setup menu. These include:

turning sound on and off
turning low-level mouse emulation on and off
turning low-level disk support on and off
turning speed control (SpeedNanny) on and off
The vast majority of customizations, though, is available 
through Bernie's Preferences window. This chapter explains 
the various preferences panels, how you can create presets, 
and attach preferences to disk images.
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1.1 Window Behavior
To open the Preferences window, choose "Preferences..." 
from the Setup menu. If you open the window for the first 
time in a session, this operation may take a few seconds as 
a lot of initialization has to take place.

To close the Preferences window, click the window's close 
box. Closing the window does not affect the preferences - all 
options retain their setting.

The Preferences window is rather large if you have a small 
monitor. Therefore, Bernie lets you shrink the window by 
clicking the zoom box of the Preferences window:

2. Presets
Bernie is offering a wide range of customizations. This 
allows you to get the most out of available resources.

Unfortunately, this also means that different applications 
require different setups. For example, you might want to 
configure Bernie to work as fast as possible with productivity 
software while entertainment software should also deliver 
rich sound. To free you from going through all the 
preferences, Bernie lets you create presets.

2.1 What's a Preset?

A preset is a group of preferences of your choice. A preset 
may contain options from one panel, selected options from 
multiple panels, or even a complete dump of all available 
customizations.



2.2 Creating a Preset

2.2.1 Creating a Preset File

The last panel - Presets - in Bernie's Preferences window 
lets you create, edit and delete presets. To create a new 
preset, open the Presets panel and bush the button "New 
Preset...":

A dialog appears asking you for a name for the new preset. 
The name you enter here must be a valid MacOS file name.

2.2.2 How Presets Are Stored

Presets are stored as files in a special folder. This folder is 
created automatically when you start Bernie for the first 
time. This folder is called "Preferences Sets" and is located 
in Bernie's application folder:

You do not need to bother about how Bernie stores presets 
since both creating and deleting preset files is done via 
buttons in the Preferences window. However, you might 
want to look at the preset files if you'd like to exchange 
presets with other users.

2.2.3 Choosing a Preset

Upon creating a preset file, you can start editing it. However, 
you first need to tell Bernie which preset you'd like to edit:

The Edit Preset popup menu lists all currently available 
presets. (The "Harddisk" item is a disk image - please turn 
to chapter "Disk Preferences" to learn more about an 
interesting variant of the presets concept.)



2.2.4 Adding Preferences to a Preset

Now that you've chosen a target preset, we're ready to add 
preferences.

Adding preferences to a preset basically means copying 
global preferences to the preset. There's a special shortcut 
for adding an option: clicking a control while holding down 
the command key.

When you command-click a control, the control retains its 
setting and becomes movable. It follows the movement of 
the cursor until you release the mouse button. At the same 
time, the white area at the bottom of the Preferences 
window pops up. This is a drop box where you can drop the 
control. The control will then be added to the currently 
selected preset. Such an action might look like this:

(Missing Picture)

The option "Speed Control" has been clicked while holding down 
the command key,

and then moved to the presets drop box.

Keep these things in mind:

When adding a control to a preset, it will be added with its 
current setting. Thus you might need to change the 
setting before adding it to the preset.

To add a slider to a preset, be sure to command-click the 
slider. Command-clicking its labels will not work.

You can only add controls, not group boxes or panel icons. 
(You can, however, add all preferences in the Presets 
panel.)

If you have command-clicked a control by mistake and 
would like to not add it to a preset, just drop it anywhere but 
in the presets drop box. A control will only added when it has 
been moved into the presets drop box.



2.2.5 Dropping a Control Gives You an Error Message

Remember that we first had to choose a preset in the 
Presets panel. In some situations Bernie deselects the 
current preset and reverts to the "none" item. This happens 
when:

deleting the current preset
mounting, unmounting (ejecting) or remapping a disk or disk 

image
In such cases, just open the Presets panel again and pick 
the preset you'd like to edit.

2.2.6 Adding All Preferences (Copy Globals)

If you'd like to add many preferences or all to a preset, it is 
very tiresome to add all controls one-by-one. That's why 
Bernie features a button in the Presets panel that lets you 
copy all preferences in one batch. Please note that this 
operation will overwrite any previously added preferences.

To add all preferences to a preset, push the Copy Globals 
button in the Presets panel.

Even if you don't need a complete set of preferences, 
adding all options first may be faster than adding individual 
settings. You can later remove specific items easily.

2.2.7 Adding Special Features

As mentioned in the introduction, some of Bernie's 
preferences are not accessible from within the Preferences 
window and thus can't be added to presets as outlined 
above. These features include mouse, sound, disk, and 
video emulation modes and are listed in the Setup menu.

For this reason, the Presets panel has a popup menu with 
which you can add those preferences to the currently 
chosen preset:
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Upon choosing one of the items from the Special Features 
menu, it appears in the list.

2.2.8 Replacing Items

If you need to change the setting of a preset's item, you 
basically need to overwrite it with the same preference and 
the changed setting:

make the desired preset the current setting
activate the panel containing the desired feature
command-click the control and drag it into the preset drop 

box

2.2.9 Deleting Items

It is likely that you might want to remove one or several 
settings from a preset at one point. Imagine you have a 
preset that looks like this:

(Missing Picture)

The illustration above shows a preset where multiple items 
have been selected. You have the following possibilities:

click an item
use the Shift key for making a contiguous selection
use Command for making disjunct selections
Upon making a selection, push the key Delete Items to 
remove the selected options from the preset.



2.3 Applying Presets

The reason you created presets is that you can easily set a 
number of preferences items to a predetermined value.

To apply a preset, you have to choices:

Make the desired preset the current preset (by selecting it in 
the Edit Preset popup menu) and push the Apply button 
below

Open the Setup menu and the Presets... submenu. This 
submenu lists all available presets. Selecting a preset 
from this menu applies the preset.

When Bernie is running, the settings it is using are those of 
the Preferences window. The settings are the global settings 
and the only ones Bernie is considering. When applying a 
preset, Bernie copies the preset's settings to the global 
settings. It is not possible to revert to the original global 
settings with an undo operation or a similar function.

2.4 Deleting Presets

To delete a preset and all settings contained within, make 
the preset the current preset and push the Delete Preset 
button.

Theoretically, a deleted preset and an empty preset both do 
nothing. Technically, however, an empty preset is still 
occupying (very little) disk space while a deleted preset is 
removed entirely from disk.



3. Disk Preferences
A preset has to be applied manually by choosing the 
corresponding menu items. Bernie also supports a concept 
referred to as "Disk Preferences". Disk preferences are 
presets that are associated with disk images. They are not 
stand-alone preferences files but rather attached to disk 
image files.

3.1 Attaching Preferences to Disk Images

Creating disk preferences works almost identically to 
creating presets. Instead of creating a new preset, however, 
you only need to mount the disk image you'd like to attach 
preferences to. Bernie automatically makes available all 
mounted disk images in the Presets panel. In the example 
below there are three disk images mounted:

(Missing Picture)

In the this particular case, there are three mounted disk images.  
They are listed in the Presets panel. To attach preferences to a disk 
image, just make it the current preset and start adding preferences.

In other words, the Edit Preset menu in the Presets panel is 
a dynamic list that always includes all mounted disk images 
plus presets you may have created on your own.

Please note that ejecting a disk image makes the disk 
unavailable and thus any preferences attached to it can no 
longer be edited, deleted or applied.



3.2 Applying Disk Preferences 
Automatically

So, what's the benefit of disk preferences over regular 
presets? Since disk preferences are associated with a 
particular software, you can tell Bernie to apply attached 
preferences whenever you are booting from such a disk 
image. In other words, whenever Bernie is booting from a 
disk image that is including preferences, Bernie is applying 
the settings.

You can enable and disable this functionality in the Presets 
panel. The check box Apply Disk Prefs When Booting From 
Image controls whether Bernie is allowed to apply disk 
preferences or not. If you disallow Bernie to apply disk 
preferences, they behave exactly as presets and you need 
to apply them manually.

Typical use of this feature is to configure games for sound 
support and joystick emulation. (You might even want to tell 
Bernie to switch to Power Mode each time you boot your 
favorite demo software.) You might want to configure your 
productivity software for maximum performance

Limitations

Please note that Bernie does only apply preferences during 
the boot process. For example, if you boot from a GS/OS 
boot disk and then launch a software that resides on a 
different disk image, there's no way to tell Bernie to apply 
settings for that particular application. You would only be 
able to specify settings for the GS/OS boot disk.



3.3 Deleting Disk Preferences

As with presets, you can delete disk preferences by pushing 
the Delete Preset button. In the case of disk preferences, 
Bernie does of course not delete the disk image. 
(Remember that disk preferences become a part of the disk 
image file.) The preferences are removed but the disk image 
stays intact.

3.4 Shared Volumes and 3.5" Floppies

Disk preferences can only be attached to disk image files. It 
is not possible to create disk preferences for (physical) 3.5" 
floppies and shared volumes.
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1. Introduction
Bernie ][ The Rescue is a full-featured emulator offering the most 
complete set of features found on an original Apple IIgs. In your 
everyday work with Bernie, however, you are typically not just 
limiting yourself to the Apple II environment but do a reasonable 
sharing of tasks between your virtual Apple II and your Mac. You 
might be using your Mac for surfing the web and checking your e-
mail while composing documents in AppleWorks Classic. Emulators 
are no longer just measured up by how they emulate a platform but 
also how well they integrate into your existing system.
Bernie Total Integration is the first serious attempt to offer true 
Apple IIgs/Mac integration and data mobility. It is a work in progress 
and will gradually evolve into - total integration. So, what can it do 
for you?

Bernie Total Integration allows you to exchange

clipboards
files
Please keep in mind that the functionality discussed herein is  
only available from within GS/OS applications, and only if they 
make use of the toolbox. (There is no way for Bernie to support 
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applications that come with a proprietary clipboard implementation.)

To exchange clipboards, Bernie adds a hotkey that enhances 
Copy and Paste commands from the Edit menu. Choosing Copy in 
a Apple IIgs application places a copy of the selected text into the 
Macintosh clipboard. Choosing Paste in a Apple IIgs application 
pastes the Macintosh clipboard.

Copying files is a snap. You can...

drag & drop files into the Apple IIgs Finder
copy files from the Apple IIgs Finder to a download folder on the 

Mac
Bernie can copy entire file trees, preserves file types and 
automatically adapts file names to the requirements of the target 
OS.

1.1 Installation

Bernie Total Integration (BTI) comes in two parts. One part is 
already built into the Bernie application while another comes as a 
GS/OS system extension: the Bernie Enabler. Hence it is not 
possible to just add the Bernie Enabler to an older copy of Bernie.

BTI requires system 6.0 or 6.0.1. Since it is a GS/OS-specific 
system file, it is not functional under any other operating system 
such as ProDOS 8 or DOS 3.3.

To install BTI follow these steps:

start Bernie with a GS/OS system disk version 6.0 or 6.0.1
mount the disk image "Bernie Total Integration" that came with the 

Bernie distribution. It is located in the folder "Total Integration".
the Apple IIgs Finder will show the disk. There is a single file on it, 

the "Bernie.Enabler".
copy this file into your GS/OS startup disk's System.Setup folder. 

(The folder is located inside the "System" folder on your 
GS/OS startup disk.)

restart GS/OS to activate the new features
A successful installation looks like this:

(MissingPicture)



The Bernie.Enabler has been copied into the System.Setup folder  
inside the System folder

Congratulations, Bernie Total Integration is now installed. If you 
have multiple GS/OS startup disks you would most likely want to 
copy the Bernie.Enabler file onto them as well.

2. Copying Files To The Apple 
IIGS

This chapter explains how you can copy files between MacOS and 
GS/OS.

2.1 Copying Files To The Apple IIgs 
Finder

The most straightforward approach is to copy files with the IIgs 
Finder being the active application. Follow these steps:

open a directory window in Bernie.

select the Mac files and drag them into an open Apple IIgs Finder 
window:

When you release the mouse button, the files will be copied to the 
directory window onto which the files were dropped. If you dropped 
the file(s) into the desktop area or some other place other than a 
directory window, the file(s) will be copied to a special folder. (See 
section 2.2.)

We recommend you that you keep the status bar visible: Bernie will 
display the current file and tell you when the copy session is done 
with.

During a copy session Bernie does not respond to any other events.



File Types and Names

File types are preserved. Types encoded to PC/File Exchange 
standards will be applied. Although files may have a generic ("dog-
eared") icon on the Mac, their original file type will restored when 
they are copied back.

Unfortunately, the ProDOS file system has very restrictive naming 
conventions. Therefore, Bernie converts file names by providing a 
close match.

Size Limitations

There is no limit on how many files or folders can be copied except 
that you might run out of available memory. The file expansion 
algorithm goes a number of extra miles for saving memory, so this 
is rather unlikely.

Duplicate Files

Bernie does not replace duplicate files by default. If you rather 
prefer the opposite, that is, want to give Bernie permission to delete 
a duplicate file in the destination directory, there's a check box for 
enabling this option. Please see chapter 3.2 for details.

2.2 Copying Files To A GS/OS Application

The previous section explained how to copy files with the IIgs 
Finder running. It is, however, also possible to copy files in any 
other GS/OS desktop application.

When you drop files into the Apple IIgs Finder and there's no Finder 
directory window open or no Finder around, Bernie puts the files 
into the folder

<startup disk>:Bernie.Transfer:
Bernie will create the transfer folder automatically if it doesn't 
already exist.
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3. Copying Files To The 
Macintosh

3.1 The Bernie.Transfer Folders

Copying files from the Apple IIgs to the Mac works slightly differently 
than the other way around. Since it's not possible to drag&drop files 
outside the video window, Bernie Total Integration introduces 
"transfer folders". Whenever you drop files or folders into a transfer 
folder, you indicate Bernie that you'd like to copy the data to a Mac 
disk.

To prepare for future IIgs->Mac copy sessions, create a folder titled 
Bernie.Transfer on any disk you like and in whatever directory. You 
can even have multiple transfer directories around, such as one on 
the desktop and another one in your working directory. As long as 
you call them Bernie.Transfer, Bernie will figure it out. These 
directories will stay empty anyway (exception: see chapter 2.2, 
"Copying Files To A GS/OS Application").

3.2 Preparing For File Transfers

Before you can copy files, you need to tell Bernie where to put the 
files on your Macintosh hard disk. The preferences window has a 
dedicated "Total Integration" section where you can pick a download 
folder:

Pick a download location by pushing "Select Download Folder"

You need to choose a download location only once. All subsequent 
copy operations will use that folder.



There's also a check box "Overwrite duplicates". By default, 
Bernie refuses to replace files in the target directory and will 
generate an error in the error log. By checking "Overwrite 
duplicates", you give Bernie permission to permanently delete files 
at the target destination so the copy operation can be completed. 
Please use this option wisely as it may result in loss of data!

3.3 How To Copy Files

Now that you created a transfer directory or chose a download 
folder, let's push some bytes around. Grab a folder and drag&drop it 
onto the transfer directory:

Here we're dragging the System folder into the transfer directory

Bernie will start copying the files. This process may take some time. 
Again we recommend that you keep the status bar visible so you 
know what's going on. The status bar will display the currently being 
copied. The message "Done" appears when all files have been 
processed.

4. Error Reporting
Bernie Total Integration comes with very explicit error reporting 
when things go wrong during a copy session.
When an error occurs, Bernie opens a dedicated window where it 
keeps track of the ten most recent errors. It lists each incident with 
the file's pathname, a human-readable description of the problem 
plus during what kind of copy session the problem occurred:

The window has a capacity of 10 items. The oldest item will be 
deleted when a new error occurs.



Please remember that Bernie does not really like replacing files - for 
your data's security. If you want to explicitely overwrite duplicates:

when copying files from the Mac to the GS, hold down the option 
key when dropping the files into Bernie

when copying files from the GS to the Mac, check the box "replace 
duplicates" when Bernie is asking for the download location

The error messages will be preserved when closing and reopening 
the window. To open it, choose "Copy Errors" from the Window 
menu.

5. Shared Clipboards
Bernie Total Integration enhances the standard Copy and Paste 
commands so that you can directly access the Macintosh clipboard:
you can paste the Mac clipboard into a IIgs desktop application
you can copy text from a IIgs desktop application to the Mac 

clipboard
To activate the enhanced Copy&Paste functions, hold down the 
option key while choosing the Copy or Paste menu items.

Bernie supports plain ASCII text only. You can't copy&paste styled 
text or pictures.

Example: Pasting the Mac clipboard into a GS/OS 
application

Assume the Mac clipboard contains the following:

(Missing Picture)

Now hold down the option key and choose the Paste command 
from the File menu:

Choose Paste while holding down the option key

...which yields the following result:



Example: Copying the IIgs clipboard to the Mac 
clipboard

Analogously to the previous example, highlight some text and copy 
it to the clipboard. Remember to hold down the option key:

Choose Copy while holding down the option key

...yields:

(MissingPicture)

6. Cross-Platform Aliases
Bernie Total Integration 1.2 introduces cross-platform aliases. A 
cross-platform alias is a link to a GS/OS application or document. 
The link is stored on your Macintosh hard disk. Upon double-
clicking an alias file, the following happens:

if not already running, Bernie will be launched
when Bernie has finished booting into GS/OS, the application will 

be started
if you clicked a document link, the document will be opened
Cross-platform aliases only work within GS/OS. It is assumed that 
you have configured Bernie so that it automatically mounts a 
GS/OS startup disk with Bernie Total Integration installed. If Bernie 
does not mount GS/OS disks automatically, lacks the Total 
Integration extension or the Finder will not become the active 
application for whatever reason, the alias will be queued until all of 
the former conditions are met.

To create an alias, start the Apple IIgs Finder and select a single 
document or application:



Make an alias by selecting an application or document and 
choosing "Create Alias..."

Then open the "Extras" menu and choose "Create Alias...". Bernie 
will open a Save As dialog for saving the alias to a Mac disk.

Note: if the Extras menu does not appear on your system, the 
GS/OS system disk you're using has not been enhanced with 
Bernie Total Integration. Please see chapter 1.1 for installation.

-End-

Mac, Apple IIgs, SmartPort, GS/OS, Finder, MacOS, ProDOS, DOS 3.3, 
AppleWorks are trademarks of Apple Computer Inc. All other brand names are 
trademarks of their respective holders.
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